USER'S MANUAL
I – USING SOPRO IMAGING ................................................................................................... - 6 -

1. Description ................................................................................................................... - 6 -
   1.1. Introduction ............................................................................................................. - 6 -
   1.2. Working principle ................................................................................................. - 6 -

2. Security module .......................................................................................................... - 7 -
   2.1 Security levels ......................................................................................................... - 7 -
   2.2 To modify the security module ............................................................................... - 7 -
      2.2.1 To modify the security level .............................................................................. - 7 -
      2.2.2 Data encoding ................................................................................................... - 8 -
   2.3 Management of the password and of the ID user .................................................. - 10 -
      2.3.1 To create a password and/or an ID user ......................................................... - 10 -
      2.3.2 Modification of the password and/or the ID user ............................................ - 10 -
      2.3.3 Non respect of the conditions of the requested security levels ...................... - 11 -
   2.4 Identification of the password and/or ID user ....................................................... - 12 -

3. The various menus in the software .............................................................................. - 13 -
   3.1. File menu .............................................................................................................. - 13 -
      3.1.1. Setup ................................................................................................................ - 13 -
      3.1.2. Backup ............................................................................................................. - 13 -
      3.1.3. Exit: exit the Sopro Imaging application ......................................................... - 14 -
   3.2. The Patient menu .................................................................................................. - 15 -
      3.2.1. New: create a new patient file ....................................................................... - 15 -
      3.2.2. Search: search a patient file ......................................................................... - 16 -
      3.2.3. Modify: modify a patient file ......................................................................... - 18 -
      3.2.4. Delete: delete a patient file ........................................................................... - 21 -
      3.2.5. Previous / Next: to reach previous or next patient ....................................... - 22 -
      3.2.6. Patient ID modification .................................................................................. - 22 -
      3.2.7. DAP history ..................................................................................................... - 22 -
   3.3. The Doctor menu .................................................................................................. - 23 -
      3.3.1. New: create a new practitioner .................................................................... - 23 -
      3.3.2. Choose: select a practitioner ......................................................................... - 24 -
      3.3.3. Edit: edit a doctor file .................................................................................... - 24 -
      3.3.4. Delete: delete a practitioner ......................................................................... - 25 -
   3.4. The Image menu .................................................................................................. - 26 -
      3.5.1. Sopix Capture/PSPIX ..................................................................................... - 27 -
         3.5.1.1 Sopix Capture system with USB system .................................................. - 27 -
         3.5.1.2 Sopix Capture with a Wireless system .................................................... - 28 -
         3.5.1.3 Sopix Capture system with a Sopix² ......................................................... - 30 -
         3.5.1.4 PSPIX Capture ........................................................................................ - 31 -
         3.5.1.5 PSPIX² Capture ....................................................................................... - 32 -
      3.5.2. Creating a new Full Mouth Series (FMS) ....................................................... - 33 -
      3.5.3. Color images ................................................................................................. - 41 -
      3.5.4. Movie capture ........................................................................................------- - 42 -
      3.5.5. SoproShade .................................................................................................... - 42 -
      3.5.6. SOPROLIFE .................................................................................................. - 45 -
      3.5.7. Calibration ...................................................................................................... - 53 -
      3.5.9. TWAIN Source ............................................................................................. - 57 -
   3.6. Display menu ....................................................................................................... - 58 -
   3.7. Help menu .......................................................................................................... - 59 -
      3.7.1. Help sections: help index ............................................................................. - 59 -
      3.7.2. Clinical booklet ............................................................................................. - 59 -
      3.7.3. SOPRO Update: live software updates ......................................................... - 59 -
      3.7.5. SAV Report .................................................................................................... - 59 -
      3.7.6. About Sopro Imaging .................................................................................... - 59 -

4. Configuring Sopro Imaging .......................................................................................... - 60 -
   4.1. The Main tab ....................................................................................................... - 60 -
      4.1.1. Images folder ............................................................................................... - 60 -
      4.1.2. Maintenance ................................................................................................. - 61 -
      4.1.3. Data saving folder ....................................................................................... - 62 -
5. Operation of image processing

5.1. The patient file

5.2. Change display

5.2.1. The tool bar

5.2.2. The status bar

5.2.3. Test pattern
6. Radiology tools ........................................................................................................ - 127 -
   6.1 Analysis tools .................................................................................................. - 127 -
      6.1.1. Rotation .................................................................................................. - 128 -
      6.1.2. Symmetry up/down ............................................................................... - 129 -
      6.1.3. Symmetry right/left .............................................................................. - 130 -
      6.1.4. Pseudo color ......................................................................................... - 131 -
      6.1.5. Zoom ...................................................................................................... - 132 -
      6.1.6. Level extraction ...................................................................................... - 133 -
      6.1.7. Relief ...................................................................................................... - 134 -
      6.1.8. Reset ...................................................................................................... - 135 -
      6.1.9. The “Flashlight” tool ............................................................................ - 136 -
      6.1.10. Histogram ............................................................................................ - 137 -
      6.1.11. Comments ............................................................................................ - 138 -
   6.2. Processing tools ............................................................................................... - 141 -
      6.2.1. Length measurement ............................................................................. - 142 -
      6.2.2. Angle measurement .............................................................................. - 143 -
      6.2.3. Video inversion ...................................................................................... - 144 -
      6.2.4. Contrast .................................................................................................. - 145 -
      6.2.5. Border enhancement ............................................................................. - 146 -
      6.2.6. 3D .......................................................................................................... - 147 -
      6.2.7. Density ................................................................................................... - 148 -
      6.2.8. Channels ................................................................................................ - 149 -
      6.2.9. Implant ................................................................................................... - 150 -
      6.2.10. Deleting an image .............................................................................. - 151 -
   6.3. Management tools ........................................................................................... - 155 -
      6.3.1. The date .................................................................................................. - 156 -
      6.3.2. The location ........................................................................................... - 157 -
      6.3.3. Comment ............................................................................................... - 158 -
      6.3.4. Image features ....................................................................................... - 159 -
      6.3.5. Closing an image .................................................................................. - 160 -
   6.4. The drawing tools ........................................................................................... - 162 -
      6.4.1. Drawing .................................................................................................. - 163 -
      6.4.2. Trace ...................................................................................................... - 164 -
      6.4.3. Rectangle ............................................................................................... - 165 -
      6.4.4. Ellipse .................................................................................................... - 166 -
      6.4.5. Polygon .................................................................................................. - 167 -
      6.4.6. Text ........................................................................................................ - 168 -
      6.4.7. Deleting a drawing ................................................................................ - 169 -
      6.5. The tool bar ................................................................................................. - 170 -

7. Imaging tools ........................................................................................................ - 169 -
   7.1 Analysis tool .................................................................................................. - 170 -

SOPRO IMAGING USER MANUAL - 4 -
REF. 011418 D
7.1.1. Rotation ........................................................................................................... - 169 -
7.1.2. Horizontal symmetry ..................................................................................... - 169 -
7.1.6. Reticle ............................................................................................................. - 169 -
7.2 Processing tools .................................................................................................. - 170 -
  7.2.1. Channels ....................................................................................................... - 170 -
  7.2.2. Deleting an image ......................................................................................... - 170 -
7.3 Management tools ............................................................................................ - 170 -
  7.3.1. The date ....................................................................................................... - 170 -
  7.3.2. Location ....................................................................................................... - 170 -
  7.3.3. Comments .................................................................................................... - 170 -
  7.3.4. Properties of the image ................................................................................ - 171 -
  7.3.5. Closing an image .......................................................................................... - 172 -
7.4 Drawing tools .................................................................................................... - 173 -
  7.4.1. Drawing ....................................................................................................... - 173 -
  7.4.2. Trace ............................................................................................................ - 173 -
  7.4.3. Rectangle ..................................................................................................... - 173 -
  7.4.4. Ellipses ......................................................................................................... - 173 -
  7.4.5. Polygon ........................................................................................................ - 173 -
  7.4.6. Text .............................................................................................................. - 173 -
  7.4.7. Deleting a drawing ....................................................................................... - 173 -
7.5 SoproShade® tools ............................................................................................ - 173 -
  7.5.1. Image capture ............................................................................................... - 173 -
  7.5.2. Deleting an image ......................................................................................... - 173 -
  7.5.3. The tool box ................................................................................................. - 173 -
  7.5.4. Monochrome ............................................................................................... - 174 -
  7.5.5. Sending the SoproShade® folder by mail ..................................................... - 174 -
7.6 The SOPROLIFE tools ...................................................................................... - 175 -
  7.6.1. The capture mode ....................................................................................... - 175 -
  7.6.2. Capturing the image ..................................................................................... - 175 -
  7.6.3. Deleting an image ....................................................................................... - 175 -
  7.6.4. An image's properties .................................................................................. - 175 -
  7.6.5. The toolbox ................................................................................................. - 175 -
  7.6.6. Automatic mode / spacebar ....................................................................... - 175 -
  7.6.7. Setting an alert ............................................................................................ - 175 -
  7.6.8. Consultation mode ...................................................................................... - 176 -
  7.6.9. Comparison mode ...................................................................................... - 176 -
  7.6.10. Anti-clockwise direction ......................................................................... - 176 -
  7.6.11. Closing a SOPROLIFE status .................................................................... - 176 -
7.7 Video tools ......................................................................................................... - 177 -
  7.7.1. Recording a video sequence ....................................................................... - 177 -
  7.7.2. Recording audio comments ....................................................................... - 177 -
  7.7.3. Capture of an image ................................................................................... - 177 -
  7.7.4. Full window ................................................................................................. - 177 -
  7.7.5. Full screen ................................................................................................. - 178 -
  7.7.6. Slow motion ............................................................................................... - 178 -
  7.7.7. Video editing ............................................................................................... - 178 -
7.8 The tool bar ........................................................................................................ - 178 -
8. Networking .......................................................................................................... - 179 -
1. Description

1.1. Introduction

The Sopro Imaging software is the user interface of the Sopix, PSPIX, SOPROLIFE systems and Sopro cameras. Sopro Imaging is a multiple-purpose program that lets you acquire, process, and archive X-rays taken with the Sopix or PSPIX system, color images, and video clips taken with an intra-oral camera – notably SOPRO cameras.

The Sopro Imaging software has been designed to be convenient and user-friendly. It is intuitive and extremely simple to use yet powerful.

Its ergonomics have been specially designed for chair-side use.

The imaging software can be used for evaluation during 31 days; then you need to activate it.

Any update to a major version of the software (eg: upgrading from version 2.10 to version 2.20) requires a new user licence.

1.2. Working principle

Sopro Imaging works in an innovative manner because it emphasizes ease of use: each image (X-ray image or color image) is rendered in an independent display area.

All the tools are parameterizable and are grouped in the same processing area with a simple display that highlights the six most-frequently used features.

The processing tools are represented by simple and intuitive icons that are interchangeable by simply dragging and dropping.

Each tool has two statuses: active and inactive. When a tool is selected, it becomes active, and the button illuminates. This way, the user always knows which feature is currently being used.

Three display modes are provided, allowing each practitioner to adopt the working method he prefers. The working principle is the same no matter which display mode is chosen: each image is associated with a pallet of six tools.

All information concerning the patient is always available via just one click.

**NOTE**

This chapter describes the Sopro Imaging software and explains how it works. When explaining the various features and their effects on images, we will use the images contained in the test patient file for "John SMITH".

**NOTE**

To start the interactive tour of how the software works, invoke the on-line help by pressing the "F1" key after starting Sopro Imaging.

For faster understanding, you are advised to run the program and execute the instructions below progressively as you read.

Start Sopro Imaging by double clicking on the Sopro Imaging shortcut icon available on the desktop in order to run the program, and then select the test patient file for John Smith by double-clicking on his name.

Previously, create a new practitioner in order to reach the patient files.

For more information, refer to the point 3.3.
2. Security module

Sopro Imaging integrates a security module which secures the software access but also encodes the patient data.

⚠️ WARNING

In case of networking, it is important that all the posts use the same version of Sopro Imaging.

2.1 Security levels

The security module is split into four security levels:

Level 0: security zero
Sopro Imaging doesn’t encode the patient data and doesn’t secure the software access.

Level 1: Low security level
An optional password is required to access the Sopro Imaging software. However, level 1 doesn’t encode the patient data.

Level 2: Medium security level
An optional password is required to access the Sopro Imaging software, and the patient data are encoded.

Level 3: High security level
Both an ID user and an optional password are required to access the Sopro Imaging software, and the patient data are encoded.

However, level 3 must respect some rules:
- An ID User field is added so as to identify the doctor. It must have at least one character which must be changed every six months.
- The password must have eight characters and must be renewed every three months.

⚠️ WARNING

In level 3, it is impossible to use a password or an ID user which has already been created.

NOTE

Default setting: the Sopro Imaging software puts itself in security level 0.

2.2 To modify the security module

2.2.1 To modify the security level

⚠️ WARNING

In case of networking the Sopro Imaging software, only one intervening party may be connected so as to modify the security level.
To modify the security level, one must click on the « File » menu then choose « Setup »:

The following window appears:

![SOPRO Imaging Setup window]

Select the list box « security » and modify the security level

The following rules give all the possibilities of level choice:

- In level 0, levels 1, 2, 3 are accessible.
- In level 1, levels 0, 2, 3 are accessible.
- In level 2, level 3 is accessible.
- In level 3, level 2 is accessible.

**NOTE**

For each modification, security systems messages appear in order to confirm the level change.

**WARNING**

It is strictly impossible to go from an encoded level (2 and 3) to a non-encoded level (0 or 1).

2.2.2 Data encoding
After having selected the security level 2 or 3, an encoding process of the data starts.

A progress bar appears showing the process state.

**NOTE**

**Before launching the encoding process of the data, it is highly recommended to save the data.**

**WARNING**

**It is strictly forbidden to stop this process. The consequences could be irreversible.**

The dialogue box « Doctor » appears, one must enter a password for levels 2 and 3, and a user ID for level 3.

A confirmation dialogue box displays:
2.3 Management of the password and of the ID user

2.3.1 To create a password and/or an ID user

Click on the « Doctor » menu, then choose « New »,

A window appears:

Fill in the password field for levels 1, 2, and 3 and the ID user for level 3.

This confirmation dialogue box appears.

WARNING

In level 3 it is impossible to fill in a password or an ID user which has already been created.

2.3.2 Modification of the password and/or the ID user

Click on the « Doctor » menu, and then choose « Modify ».

A dialogue box appears:
It is then possible to modify your password and your ID user for level 3 if necessary.

After having modified the password, a confirmation window appears:

![Confirmation Window]

⚠️ WARNING

**In level 3 it is impossible to fill in a password or an ID user which has already been created.**

2.3.3 Non respect of the conditions of the requested security levels

In case of networking, if the doctor has determined a security level 1.2.or 3 and if the other doctors have a lower security level, they must enter a password for levels 1.2.or 3 and an ID user for level 3.

When opening a doctor file, the dialogue box « Doctor » appears, a password and an ID user for level 3 must be entered.

![Doctor Dialogue Box]

A confirmation window of the password for level 3 appears:
2.4 Identification of the password and/or ID user

When launching Sopro Imaging and each time you open the « doctor » file, a dialogue box appears so as to identify:

In level 1 and 2, one must fill in the password; in level 3, one must fill the password and the user ID.
3. The various menus in the software

3.1. File menu

Its purpose

This menu allows you to parameterize the main features of the software, to perform data backups, and exit the application.

How to invoke it

By clicking on the « File » menu:

![Menu Options]

3.1.1. Setup

This feature allows you to set the parameters of the main software’s features. It is explained in detail in point “4” of this chapter.

3.1.2. Backup

To perform data backups, click on the « File » menu then choose « Backup »:

![Backup Dialogue]

This action opens the following dialogue box:

Click on « Ok » to restart backup process.

⚠️ WARNING

Beforehand, it is important to transfer the image folder to the data-saving folder otherwise the option will be displayed in grey tint. For more information, please refer to point 4.1.3 of this chapter.
3.1.3. Exit: exit the Sopro Imaging application

To exit the Sopro Imaging application, open the “Patient” menu and then click on “Quit”:

![Menu](image)

This action opens the following dialog box:

![Backup Dialog](image)

As explained in the message above, you must save any entered data and execute the backup operation before exiting the application. Then click on “OK”.

To enter the path to the folder in which to save data, refer to the point covering the control panel: point 4.1.3.
3.2. The Patient menu

Its purpose

This menu allows you to create, edit, search and delete patient files as well as reach the previous or next patient file and to modify its ID modification.

How to invoke it

By clicking on “Patient”

<table>
<thead>
<tr>
<th>Patient</th>
<th>Image</th>
<th>Doctor</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Previous</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient ID modification...</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3.2.1. New: create a new patient file

To create a new patient sheet, enter the "Patient" menu then click on "New" or click on the icon or hold down the “Ctrl” and “N” keys on your keyboard:

The following file window displays (in this window, enter civil status information about the patient by entering information items in the requested fields):

To move from field to field, just position the cursor over the field into which you want to make an entry and then left-click once to place the insertion point in the said field.
IMPORTANT
It is mandatory to enter a value in the Last Name and First Name fields.

NOTE
Concerning the doctor section, it is possible to associate a doctor to a patient. The latter will not be visible by the other listed ones. For more information, please refer to the point 4.2.7.

To be able to enter the date of birth quickly, click on the "Date of Birth" box: a Windows dropdown menu opens:

- Click on the displayed month, and then choose the appropriate month from the dropdown menu that opens.
- Click on the year, and then choose the year with the cursor.
- Then, select the day by clicking on it in the calendar.

The program automatically assigns a number to the patient file. This number corresponds to the chronological order of creation of the file in the patient database.

Once all fields contain an entry, click on "OK" to accept the file.

3.2.2. Search: search a patient file

There are several ways of searching a patient file: you should click on the "Patient" menu then choose "Search" or click on the icon or hold down the “Ctrl” and “O” keys on your keyboard:

In the window that then opens on-screen:
Several options are then available for selecting a patient file:

- Indicate the first letters of the last name or first name in the Search filter field, then validate by pressing the button "X".

- Or indicate the patient file number in the Search filter field and validate by clicking on the button "X".

Using the Advanced search function, it is possible to do a search by INSEE number and/or by date of birth.
To activate it, click on the box provided. This option is retained from one search to another.

It is possible to modify a patient file by clicking on the “Modify” button. For more information, please refer to point 3.2.3 or 3.2.1 in this chapter.

NOTE

By default, the patient research list is always full. However, it is possible to hide it in order to protect patient confidentiality. You have to deactivate the option “Always fill the patient research list” in the setup panel, “Option” tab.

3.2.3. Modify: modify a patient file

There are two possibilities to modify a patient file that has already been created. Either by clicking on the “Patient” menu, then “Modify” or the icon:

To reach the window “Search of a patient”, click on the “Patient” menu then “search”.

One must select a patient in the listing then click on “Modify” button:
The patient's civil status record displays:

![Image of the patient's civil status record]

Edit the information as needed, and then accept your changes by clicking on "OK".

To integrate the patient's photo, the patient's file must already have been created, accepted and open in edit mode with the dialog box above displayed on-screen. Next, click in the white area containing the instruction "Click here to select the patient's photo from his image folder"; the window below opens:

![Image of the patient's photo selection dialog]

Edit the information as needed, and then accept your changes by clicking on "OK".
Click once on the image to be incorporated in the patient’s file - the selected label displays in yellow - and then accept your choice by clicking on "OK".

NOTE

The button “Modify” available in the window “Search of a patient” does not modify the patient picture.

NOTE

If you make a mistake when choosing the image, click on "Deselect image". The dialog box closes, and you can start the entire operation again.

Once the image has been retrieved, it displays automatically in the patient's file, as shown opposite.
3.2.4. Delete: delete a patient file

To delete a patient file and all the images it contains, the file to be deleted must be open on-screen for consultation; then, open the “Patient” menu and select “Delete”:

The following dialog box opens:

![Dialog Box]

Click on “Yes” to accept the deletion.

⚠️ WARNING

Deleting a patient file is an irreversible operation, and permanently deletes any information the file contains.
If the computer so allows, the images for this patient will be transferred to the garbage.
3.2.5. Previous / Next: to reach previous or next patient

To reach previous or next patient, click on the “Patient” menu then “Previous” or “Next”:

This function can be invoked via tools bar:

- The icon reaches the previous patient by means of family name.
- The icon reaches the next patient by means of family name.

3.2.6. Patient ID modification

This function assigns a new patient ID to a patient that has already been created. To do this, you should have the patient folder open, click on the “patient” menu then select “Patient ID modification”.

The following dialogue box displays:

![Patient ID modification dialogue box]

Assign a new patient ID.

⚠️ WARNING

*It is impossible to assign a patient ID that has already been created.*

3.2.7. DAP history

This function shows you the history of dose received by the patient when using the Sopix/Sopix² Inside system.

The following window appears:

![DAP History window]
You can then close the window or print its content.

### 3.3. The Doctor menu

#### Its purpose

This menu allows you to manage practitioner files, edit them or delete them. If several practitioners are using the software on a network, you can change the doctor file currently in use. For more information about using the software on a network, refer to point 8 in this chapter.

#### How to get there

Click on Doctor:

#### 3.3.1. New: create a new practitioner

To create a new practitioner, click on the "Doctor" menu and then choose "New":

The following file displays; in this window, enter civil status information concerning the practitioner by making entries in the requested fields:

![Doctor window](image)

You can enter the following information items:

- Title,
- Practitioner’s last name and first name,
- Dental surgery logo,
- A free letterhead of several lines in length.

Once you have entered this information, click on "OK" to accept the practitioner’s file.

---

**NOTE**

It is possible to create a password and/or a user ID according to the chosen security level. For more information, please refer to point 2.3.1 in this chapter.
3.3.2. Choose: select a practitioner

Sopro Imaging lets you create several practitioners. To choose a doctor, click on the "Doctor" menu and then click on "Choose":

The following window opens; select the practitioner by clicking on the name, and then accept your choice by clicking on "OK":

![Search doctor window]

**NOTE**

If only one practitioner has been created, the Sopro Imaging software does not offer you a choice and no dialog box opens. Similarly, Sopro Imaging will not prompt you to choose a practitioner each time the software starts.

3.3.3. Edit: edit a doctor file

To edit a doctor file that has already been created, click on the "Doctor" menu and choose "Modify":

The doctor’s file displays:

![Doctor file window]

Edit the information, and then accept your edits by clicking on "OK".
3.3.4. Delete: delete a practitioner

To delete a practitioner, first select the practitioner by following the instructions in point 3.3.2. Once you have selected the practitioner, open the "Doctor" menu and choose "Delete".

The following dialog box opens:

![Dialog box](image)

Click on "Yes" to confirm the deletion.

**NOTE**

Deleting a doctor does not affect patient data. You can create another practitioner with the same name at any time.
3.4. The Image menu

Its purpose

This menu allows you to:
- Export and import images. This operation is useful if you want to import or export additional images into the patient’s file;
- Delete images;
- Create an FMS
- Send image by e-mail
- Print and configure printing.

How to get there

Click on Image:

<table>
<thead>
<tr>
<th>Image</th>
<th>Doctor</th>
<th>Cap</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export…</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import…</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete…</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New FMS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send by EMail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print…</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print setup</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The various options in this menu are explained in more detail in points 5.4, 5.5, 5.7, 5.8 and 5.9 of this chapter.
3.5. The Capture menu

Its purpose

This menu lets you specify the source from which images will be taken:

- for X ray images, choose Sopix/PSPIX;
- for color images, choose Color images;
- for video sequences, choose Movie capture
- For the SoproShade, choose SoproShade.
- For the SOPROLIFE module, choose SOPROLIFE
- For checking sensor(s) quality, choose calibration.
- For analyzing X ray emission curve, choose oscilloscope.
- for other sources (such as a digital camera, for example), choose TWAIN source

How to get there

By clicking on the “Capture” menu, then on the required function.

3.5.1. Sopix Capture/PSPIX

Sopix/PSPIX capture is used for the acquisition of an image with a system in the range. To access this function, click on "Capture" then “Sopix/PSPIX” or on the icon or press "F9" key:

The Sopix/PSPIX control box displays in the foreground. It can be placed anywhere on the screen. To do so, simply hold down the left mouse button over the box and drag it over the application.

It is also possible to resize the SOPIX / PSPIX control box using its handle at the bottom right corner.

**NOTE**

If SOPIX or PSPIX control box is deactivated, it will not be automatically activated at the launch or change of a patient.

**NOTE**

As soon as the program is launched, the Sopix /PSPIX Control box gets the upper hand on the other programs.
From one session to another, the Sopix / PSPIX control box keeps its position.

According to the system used, the ergonomics and functionalities of the control box are different.

3.5.1.1 Sopix Capture system with USB system

The Sopix control panel is the dialog box that gives you an on-screen display showing the system’s status, the mode for positioning the sensor in the mouth, and the type of resolution selected.

A - System status

Three indicators display on-screen, i.e. from left to right: green, yellow and blue/red.
Three possibilities are offered:

- when the system is connected, the green indicator is illuminated continuously and the yellow indicator flashes. This means that the system is on standby for acquisition;
• during image acquisition, only the blue indicator on the right of the control panel remains illuminated;

• the red indicator illuminates when the software detects a problem, as shown below:

This error arises from a connection problem:

• between the sensor and the controller; in this case, make sure you connect the sensor to the box properly;
• between the controller and the computer (USB cable disconnected at one end or the other). Check the connection.

These indications are partly a reproduction of the indicators on the front of the controller. For more information, refer to point 1.2.2 of chapter 2.

B - Sensor positioning

It also allows you to select the positioning of the sensor as a function of the area to X-ray, so that the image always displays in the right direction.

To do this, before triggering the timer, click once on the position of the sensor in the patient’s mouth, as shown opposite.

C - Acquisition mode

The HR and LR indicators let you select the image acquisition mode.

By default, LR mode is always illuminated. To change mode before taking the X-Ray image, click on the HR indicator. You can set HR mode to be the default mode; to do this, refer to point 3.8 in this section.

D - Setup

Click on the “setup” button in the acquisition module to open the setup window. For more details, refer to chapter “4.14.1 Sopix USB (First generation) setup”.

E - Closure

Click on the “Closure” button to close the acquisition module. Note that the acquisition module will be restarted if the product selection is still activated.

3.5.1.2 Sopix Capture with a Wireless system

The Sopix Wireless control box is the dialog box that displays on screen the state of the system, the sensor positioning mode, the charge level of the batteries and the type of resolution selected.

A - System status:

Three indicators display on-screen, i.e. from left to right: blue/green, yellow and blue/red.

• When the Sopro Imaging software is launched, a light blue indicator lights up, representing the initialization phase between the system and the software.
• The yellow indicator light, at the middle of the control box, flashes to indicate that the system is ready to get an X-Ray image.

• The blue indicator light, at the right of the control box, indicates that Sopro Imaging is integrating the image.

• The red indicator light can advise:
  - The control box is switched “off” (notably when the X-Ray image has been integrated into the software)
  - The software has lost communication with one of the elements of the system (controller box and/or sensor).

In both cases, please refer to the chapter II “Quick Troubleshooting” in this manual.

⚠️ WARNING

Check that the orange indicator light is flashing before you take any X-Ray image.

B – Sensor positioning

It also allows you to select the positioning of the sensor as a function of the area to X-ray so that the image always displays in the right direction. To do this, before triggering the timer, click once on the position of the sensor in the patient’s mouth, as shown opposite.

C – Battery level

The “battery symbol” allows having a representation on the screen of the battery level. Three states are represented:

When the “battery symbol” is green, it means that there is still enough autonomy.

When the “battery symbol” is orange it means that the battery level has weakened. The system should be recharged.

When the “battery symbol” turns red and flashes, it means the battery level is critically low and it is imperative to charge the system.

⚠️ WARNING

When the “battery symbol” turns red, it is highly recommended not to take X-Ray images. Indeed these could be lost before they were retrieved in the computer.

D – Acquisition mode

The HR and LR indicators let you select the image acquisition mode. By default, LR mode is always illuminated. To change mode before taking the X-Ray image, click on the HR indicator. You can set HR mode to be the default mode; to do this, refer to point 3.8 in this section.

E – Setup

Click on the “setup” button in the acquisition module to open the setup window. For more details, refer to chapter “4.14.2 Sopix Wireless (First generation) setup panel”.
F - Closure

Click on the “Closure” button to close the acquisition module. Note that the acquisition module will be restarted if the product selection is still activated.

3.5.1.3 Sopix Capture system with a Sopix²

The Sopix II control panel is the dialog box that gives you an on-screen display showing the Sopix² system status and the mode for positioning the sensor in the mouth and the exposure level.

A - System status

Two indicators display on-screen, i.e. from left to right green/yellow and blue/red. Three possibilities are offered:

- when the system is connected, the green indicator is continuously illuminated and the yellow indicator flashes. This means that the system is on standby for acquisition;
- during the image acquisition process, the blue and green indicators control panel permanently remain illuminated;
- the red indicator illuminates when the software detects a problem, as shown below:

B - Sensor positioning

The SOPIX² control box you to select the sensor positioning according to the X-ray-area, so that the image always displays in the right direction. To do this, before triggering the timer, click once on the sensor position inside the patient's mouth.

C - Exposure factor:

The area located at the bottom of the control box represents the exposure factor just after an image acquisition.

This allows the user to adjust the exposure level on his X-ray generator if he thinks his image is too light or too dark. If green indicator light appears at the right hand side of the yellow X-ray mark, this indicates the dose economy made thanks to Sopix/Sopix² Inside. This function is also available in percentages in the info screen that appears with each acquisition made and in the image proprieties.

D - Setup

Click on the “setup” button in the acquisition module to open the setup window. For more details, refer to chapter “4.14.3 Sopix² / Sopix setup panel”.

E - Closure

Click on the “Closure” button to close the acquisition module. Note that the acquisition module will be restarted if the product selection is still activated.
3.5.1.4 PSPIX Capture

The PSPIX control is a dialog box which represents the PSPIX system’s status on the screen and the sensor’s positioning mode in the mouth.

A - The system’s status:

2 indicator lights are displayed on the screen from top to bottom: green/yellow, blue/red:
3 options are offered:

- When the system is connected, the green indicator light remains permanently lit and the yellow indicator light flashes. This indicates that the system is waiting to acquire data.

- While the image is being retrieved, the green indicator light and the blue indicator light remain permanently lit.

- The red indicator light goes on when software detects an abnormal occurrence as shown below:

B - Positioning the sensor

The system also allows selecting the sensor’s positioning according to the area to be x-rayed; enabling the image to always be displayed in the right direction.
To do this, simply click once on the sensor’s position according to the positioning in the patient’s mouth before inserting the ERLM in the PSPIX system.

C - Setup

Click on the “setup” button in the acquisition module to open the setup window. For more details, refer to chapter “4.13 PSPIX setup”.

D - Closure

Click on the “Closure” button to close the acquisition module. Note that the acquisition module will be restarted if the product selection is still activated.
3.5.1.5 PSPIX² Capture

The PSPIX² acquisition module gives you information about the PSPIX²’s status and allows you to book or free the PSPIX² for your workstation in multi-user configuration.

A - The system’s status

You have two indications on the PSPIX²’s status:

**PSPIX² icon:** PSPIX² icon switches on when the workstation is connected to a PSPIX² scanner.

**Imaging plate icon:** the color of the imaging plate icon depends on the status of the scanner:
- Blue: available
- Yellow: booked in multi-user configuration
- Purple: scanning
- Orange: disconnected/problem
- No imaging plate: setup menu opened into the PSPIX² touchscreen

B - Reservation

In multi-user configuration, a padlock appears on the right-hand corner of the acquisition module.

- To book the PSPIX² for your workstation, click on the padlock button. The scanned image will be directly sent and displayed on your workstation.
- Once you have finished to use the scanner, you are able to free the PSPIX² by clicking another time on the padlock button. If not, the PSPIX² will automatically be freed after the reservation duration, that can be configured in the PSPIX² setup (please refer to chapter “4.12 PSPIX² setup” p.89)
- If the PSPIX² is booked for another workstation, the padlock, is inactivated and the number of this workstation appeared on the bottom of the padlock.

C - Setup

Click on the setup button in the acquisition module to open the setup window. For more details, refer to the chapter “4.12 PSPIX² Setup”.

D - Closure

Click on the closure button to close the acquisition module. Note that the acquisition module will be restarted if the product selection is still activated.
3.5.2. Creating a new Full Mouth Series (FMS)

Its purpose

This feature allows you to create a new FMS that the user will choose to fill in during the acquisition of X-Ray images or afterwards.
In any case, you have to choose first the format that will accommodate the X-Rays.

How to get there

To create a new FMS, click on: "Image"; "New Status"; or click on the icon

This action opens a dialog box that lets you choose the format of the FMS that the user will choose to fill-in.

NOTE
For optimal use of the FMS feature, it is preferable to use both sizes of sensor.

A - Choosing the format of the FMS

Sopro Imaging lets you choose from among seven different FMS formats.
By default, the FMS selected is the first from the top left:

![Select FMS layout](image)

To gain access to the last FMS format, slide the scroll bar to the right. The last FMS format displays on the right-hand side of the dialog box:
To select and open an FMS format:

- click once on it and then accept your choice by clicking on "OK" or:
- Double-click on the FMS format you want to select.

Each FMS format is designed for a different purpose; a distinction is drawn between adult patient FMS and pediatric FMS.

**Adult FMS:**

A. This FMS format allows one to obtain an image of the patient's entire mouth (except for the bite-wings). It requires a sensor size.

B. This FMS format allows one to obtain only the patient's top and bottom teeth: -UR1, UR2 - UL1, UL2 - LR1, LR2 - UR1, UR2).

E. This FMS format allows one to obtain four bite-wings. This method is recommended for checking the patient's occlusion.

F. The numeric FMS provides twelve image areas that can each accommodate an X-Ray containing two or three teeth. This FMS is provided for the use of size 2 sensors.

G. H. The multiple-sensor FMS is specially designed for the use of digital radiology sensors of size 1 and size 2. It is based on the standard dental radiological FMS, and provides the best result possible.

**Child's FMS:**

C. This format of FMS is recommended for pre-adolescents, and allows one to obtain a representation of the definitive and lacteal teeth of a young patient.

D. The pediatric FMS provides four image areas that can each accommodate an X-Ray containing either incisors or bitewings. This FMS is provided for very young children.

**NOTE**

The last FMS format selected will be automatically pre-selected.
**B - Filling-in an FMS**

The FMS can be filled-in in two ways.

---

**NOTE**

In the examples below, we will use the FMS template A described above, with the test set of X-Ray images for the patient "John Smith". The last FMS format used will be automatically selected.

---

**B.1. During acquisitions**

Once the FMS has been selected (as explained in point 3.5.1) you should set the software in acquisition mode by opening the "Capture" menu and choosing "Sopix":

You will then see the following window:

![Capture Window Example](image.png)

In this example, the cursor is positioned on boxes "LL2, LL3", which means that the sensor should be placed in the patient's mouth for the acquisition of teeth LL2 and LL3, making sure that before you take the X-Ray, you position the sensor the right way up, by means of the Sopix control panel (as explained in point 3.5.1).

The X-Ray will be retrieved, stored the right way up in the corresponding box, as shown below:
Now, move the insertion point to the next box, position the sensor at the corresponding location in the patient's mouth, take another X-Ray, and then repeat the operation until the FMS has been completely filled-in.

**B.2 - Post-treatment**

It is also possible to assign X-Rays within an FMS after X-Rays of the patient's teeth have been taken. In this case, you have to first assign a location to each of the X-Ray images.

When you select the automatic filling-in command (which you will find in the menu bar at the bottom of the FMS) Sopro Imaging fills each box in the FMS with the most recently-taken image. Sopro Imaging searches for images of the currently-selected type. If no image is available for a given box, that box will be left blank. If there are several X-Rays for a given box, the most recent image will be displayed.

**IMPORTANT:**

The automatic FMS filling-in process does not necessarily provide you with a true state of the patient's mouth because old X-Rays can display if no more recent ones are available.

It is possible to complete an FMS that has already been filled by clicking on the icon
C - Processing an FMS

A tool bar associated with each FMS provides information and features for handling the various X-Ray images.

This tool bar includes the following tools:

<table>
<thead>
<tr>
<th>Rotation</th>
<th>Negative/Video inverse</th>
<th>Up-down symmetry</th>
<th>Left-right symmetry</th>
<th>Channels</th>
<th>Delete</th>
<th>Move</th>
<th>Properties</th>
<th>Automatic filling-in</th>
</tr>
</thead>
</table>

For more information about certain tools, refer to the following points of chapter 5 (or click on the corresponding links):

- Rotate - point 6.1.1
- Negative - point 6.2.3
- Up-down symmetry - point 6.1.3
- Left-right symmetry - point 6.1.2
- Channels - point 6.2.8
- Automatic filling-in - point B2

Each of these tools can be used on each X-ray label in the FMS. To do so, select the image to be processed by clicking once on it and then apply the necessary filter.

The processing applied to the image is recorded in the image's processing history. You can also open each image in the FMS by double-clicking on it.

This action opens the said X-Ray in the configured display mode: design mode, Windows mode or full-screen.

For more information about the display mode, refer to point 3.6 in this chapter.
D - Moving images in the FMS: the "Move" function

The Move function lets you move and resize the X-rays displayed within the FMS when the FMS is open for viewing. For example, the FMS could be laid out as follows:

To disable this function, click on the button again. The X-Rays will remain placed at the location to which they have been moved.

NOTE

It is possible to move an image to a different location by doing a drag-and-drop. To do this, select the image of your choice and move it by holding down the left mouse button, then releasing it when you have reached the location of your choice.

Click on the icon to add images or on the icon to delete images.

The icon allows to renumber thumbnails in order to change the sequence of it.

For that, click on the icon and select the thumbnail(s) sequence of your choice. To exit this mode, click again on this icon.
E - Deletion: to delete an image from the FMS

To delete an image from the FMS, click once on it to select it, then click once on the "Delete" button or right-click on the label and select “Delete”. The X-ray will be automatically deleted.

NOTE

This action does not permanently delete the X-ray from the patient’s image database; it only removes it from the FMS. Moreover, this function is only available within an FMS, and is not the same as the "Reset" function. For more information about the "Reset" function, refer to point 6.1.8. of this chapter.
F - Properties of the FMS

Clicking on this tool displays a window in the foreground of the screen, giving you information about the FMS, notably the patient's file number, the patient's first and last name, and the path to the location at which this FMS is stored. You can also add notes.

In this box, enter any notes you want to save about the FMS. For example, where appropriate, you might note that this FMS was produced after treatment. Then click on “OK” to save it.

G - Save and close status

Once the status is completely filled in, changes have been made and comments added, all you have to do is close it to save it. To do that, click on the red cross at the top right of the status window.
3.5.3. Color images

Capture by “Color images” is used to acquire color images using an intra-oral camera.

To access this function, click on the “Capture” menu then choose “Color images” or click on the icon or press key “F10”:

The intra-oral camera is now active. To capture the image touch the tactile “Sopro Touch®” key on the SOPROLIFE /Sopro 595/Sopro 717/SOPRO 617 camera. If not, click on the icon ‘Image capture’

Pause button freezes an image, play button returns to live mode and stop reinitializes video flux.
3.5.4. Movie capture

Capture by “Movie capture” is used to acquire video clips using an intra-oral camera.

To access this function, click on the “Capture” menu then choose “Movie capture” or click on the icon or press key “F11”

The following screen appears:

To start and end a video sequence, click on the icon

However, it is possible to make a break during a movie capture. To do this, click on the icon and to take back the video clip, click on the icon

3.5.5. SoproShade

The “SoproShade” capture is a shading assistant.

To access this function, click on the “Capture” menu then choose “SoproShade” or click on the icon or press key “F12”:

A - Operating protocol of the SoproShade ® Concept
When shading using the Sopro 717 intra-oral camera, an operating protocol must be followed. For this, please refer to the "Sopro 717 user manual" supplied with the product.

**B - Use of the SoproShade® function**

**Step 1:**

Click on the "Capture" menu, select "SoproShade®" or click on the icon [image] or press key «F12»

The following window appears:

![SoproShade window](image)

During the operating protocol with the Sopro 717 intra oral camera, the image will be displayed in the control window and may be captured using the icon [image], the SoproTouch® tactile key is only used to freeze the image on the screen.

To return to live mod after an acquisition, click on the icon [image].

**NOTE**

To save the image in SoproShade 1 / 2 mode, click on the icon [image].
A comments box is provided in the bottom right hand corner of the screen which will enable you to complete the SoproShade file you will be sending to the dental lab and/or conserver or archive.

**Step 2:**

Once the protocol is finished go to the next step by clicking on the icon

The following window appears:

It shows all the images acquired by the dentist together with his comments.

It is possible to delete an image by clicking on the icon or send the “SoproShade” data to the dental lab by clicking on the icon.

For this, please refer to point 7.5 of this chapter.

**NOTE**

To return to the previous step, click on the icon.
3.5.6. SOPROLIFE

The "SOPROLIFE" capture is used only with SOPROLIFE system. It facilitates the prevention and the detection of caries by offering an anatomic vision of the tooth in a fluorescence image.

To access this function, click the "Capture" menu and then "SOPROLIFE" alternatively the icon

A- SOPROLIFE system’s operating protocol

Refer to the SOPROLIFE user’s manual which is located in the heart of the SOPRO-Imaging CD-ROM’s root

B- Using the LIFE function

Step 1: selecting a SOPROLIFE template

SOPRO-Imaging offers you a choice of 4 different templates. By default, the selected template is the first template in the upper left corner:

To select and open a SOPROLIFE template:
- Click once on your choice and validate it by clicking Ok
- Double-click the status format you want to select.

Each template is adapted to different usages:

A - Maxillary status: this template is used to only obtain the patient’s upper teeth.
B - Mandibular status: this template is used to only obtain the patient’s lower teeth.
C - Complete status no. 01: this template is used to obtain the patient’s complete mouth. Each box corresponds to a tooth number.
C - Complete status no. 02: this format is used to obtain the patient’s complete mouth. Each box corresponds to a tooth number, except for maxillary incisors, which are combined in a single box. This is also true for mandibular incisors, canines and maxillary/mandibular premolars.
D - Complete status No. 03: this format is used to obtain the complete mouth of an adult or child patient.
Step 2: Filling in a SOPROLIFE template - Capture Mode

NOTE

In the following examples, we will use the D template model described above.

Before starting to fill in a SOPROLIFE status, it is important to determine the direction of image capture.

The anti-clockwise button is represented by the icon when inactive and when active.

By default, the anti-clockwise button is inactive, which means the images are captured from left to right.

To activate the latter, left click on it once. The images will then be captured from right to left.

To capture an image with SOPROLIFE, position the mouse on the box you want; the default box is box no. 18. The image appears in the control window.

The image can be frozen using the Sopro Key or captured by pressing the button.

To return to the “live” mode after capturing an image, touch the Sopro Key or press the button.
The scroll list in the upper right corner of label no. 17 is used to preview the acquired images and to add additional images or x-ray photos present in the patient's file.

By default, the Auto Mode / spacebar is automatically activated. This means that whenever an acquisition is made, the system moves one box.

To switch to manual mode and manually change a location, simply deactivate the button and press the keyboard spacebar.

In manual mode, to change a box, use the mouse thumbwheel or the keyboard spacebar. Otherwise, all the image acquisitions will remain in the same location.

It is possible to move an image to a different location. To do this, select the image you want to move with the left mouse button, hold down the button then release it when you have reached the location of your choice.

At any moment, an alert can be set on a location. To do this, position the mouse on the desired location and press the button.
Step 3: Consulting a SOPROLIFE status – Consultation mode

To consult a SOPROLIFE status, click the button.

This button is used to display all the images acquired during the creation of the SOPROLIFE status. The selected image appears in the center of the main window.

NOTE

By double-clicking the image in the center or the location box via the scroll list, the image opens in its skin.
To add an image present in the patient file, double-click an empty box with the 📷 symbol or open the scroll list and click the label with the 📷 symbol. The following selection window appears:

You can only add one image at a time.

NOTE

It is possible to move an image to a different location. To do this, select the image you want to move with the left mouse button, hold down the button then release it when you have reached the location of your choice.
Step 4: Comparing the images in a SOPROLIFE status

You can compare the images in the same location. To do this, you must select at least two images. To activate the comparison mode, press the button.

A toolbar associated with each image offers functionalities to process the various types of images (color or x-ray photos):

For the x-ray photos:

- Rotation - point 6.1.1
- Negative - point 6.2.3
- Zoom - point 6.1.5
- Reset - point 6.1.8
- Delete an image - point 6.2.10
- Video inversion - point 6.2.3
- Consult - Step 3
For color images:

- Rotation - [point 6.1.1]
- Zoom - [point 6.1.5]
- Reset - [point 6.1.8]
- Channels - [point 6.2.8]
- Delete an image - [point 6.2.10]
- Consult - [Step 3]

**NOTE**

Depending on the type of selected image, some tools appear shaded.

**NOTE**

At any time you can access the clinical guide by clicking the [LIFE] button.

You can perform the following operations:

- Status properties - [point C]
- Print the status - [point 5.13]
- Send a status - [point 5.12]
- Export a status - [point 5.10]
C - Properties of SOPROLIFE status

Clicking on this tool displays a window providing status information, particularly the patient file, the patient’s last name and first name as well as the save path of this status. In addition, it provides space for completing the comments box.

In this box, type the information you wish to add to the status. Then click on OK to save it.

D - Save and close a SOPROLIFE status

Once the SOPROLIFE status is completed, click on the button in the toolbar to close and save it.
3.5.7. Calibration

This feature caters to European legislation in force in certain European countries - notably Germany - which requires a check (once per month) of the quality of the sensor(s) by means of a test card specially designed for the purpose.

To gain access to this feature, Click on the "Capture" menu, then choose "Calibration"; this opens the following window:

![X-ray sensors calibration dialog box]

**NOTE**

When this dialog box is open, you will not be able to consult the images of any patient. However, the calibration operation requires a patient file - any patient file - to be open. The X-Ray images taken during this operation will not be archived in the open patient file; instead, they will be stored in the "Patterns" folder in the "Images" folder at the root of the "Sopro Imaging" folder.

Once this dialog box is open, and after you have positioned the test card on the sensor, click the "Sensor Arming" button at the top of this dialog box, and then trigger the timer.

An image similar to the one below will display on-screen:

![Image similar to the one below]

This window contains five main entries:
A. **The sensor serial number**
When this window is open and when a sensor is connected, Sopro Imaging retrieves the sensor's serial number.

**NOTE**
This number is the sensor's hardware number; it is not the same as the manufacturer's serial number shown in the Sopix configuration panel in the "Sopix" tab. For more information about this tab, refer to point 4.11 in this chapter.

B. **The 'Sensor arming' button**
Clicking on this tab automatically sets the sensor (which means that it will then be ready to take the calibration X-Ray images).

C. **The X-Ray images archiving box**
All the calibration X-Ray images will be stored in this box as labels; the most-recent is placed at the top of the column.

D. **The calibration X-Ray display box**
In this box, the calibration X-Ray is displayed after it has been taken. The evaluation criteria will vary according to the test card you use. For more information, refer to the test card reseller.

E. **The processing tool bar**
In this window, the user gets access to certain image processing tools. These tools are as follows (from left to right):

- the zoom - point 6.1.5
- the rotation - point 6.1.1
the comments - point 6.3.3
the negative - point 6.2.3
the histogram - point 6.1.10
the channels - point 6.2.8
The length measurement - point 6.2.1

For more information about these tools, refer to point 6 of this manual.

3.5.8. Oscilloscope

This function allows you to analyze X ray emission curve of the generator with a Sopix II system. To gain access to this function, click on the "Capture" menu, then choose "Oscilloscope" or click on the icon; this will open the following window:

After having positioned sensor into patient's mouth, click the "Start Monitoring" button at the top of this dialog box and set up the timer.

It is then possible to continuously visualize the quantity of X ray received by the sensor.

An image similar to the one below will display on-screen
This window contains five main entries:

A. The serial number sensor.

When this window is open and when a sensor is connected, Sopro Imaging retrieves the sensor's serial number after having clicked on "Start Monitoring" button.

B. “Start Monitoring” button

This button allows you to get a new oscilloscope curve. The monitoring can be stopped at any time by using "ESC" button on your keyboard.

C. Datas archiving box

All datas will be stored in this box; the most-recent ones are at the top of the column.

D. Comments tool

For more information about this tool, refer to point 6.1.11 of this manual.

E. Zoom tool

For more information about this tool, refer to point 6.1.5 of this manual.

F. Datas display area

In this box, the oscilloscope curve will be displayed.

**NOTE**

*At any moment, it is possible to stop the monitoring by clicking on the graph area.*
3.5.9. TWAIN Source

This feature allows you to acquire images with peripherals operating under the TWAIN standard, and manage these images within Sopro Imaging; examples of such devices are digital photo and video cameras, scanners, etc.

NOTE

For Sopro Imaging to detect these devices, you must have installed the device drivers beforehand.

To perform a TWAIN acquisition, click on the "Capture" menu and then select "TWAIN Source":

A submenu will display, showing all the peripheral devices for which a TWAIN driver has been installed:

- click on the source you want to use for acquisition;
- a window will open; start the acquisition process.

The image will then be retrieved to the patient’s image list. You can repeat this operation as many times as necessary.
3.6. Display menu

Its purpose

This menu lets you specify the display of images of each category.

You can display:

- all images;
- color images;
- X-ray images;
- scanned documents;
- movie;
- imported images;
- full Mouth Series (FMS)
- external images
- SOPROLIFE status
- advanced filter
- dental chart

You can also choose between displaying images in Labels mode or in image mode details.

It is possible to display images by date of acquisition.

How to get there

By clicking on the “Display” menu, then the required function:

This menu is covered comprehensively in point 5.2 of this chapter.
3.7. Help menu

Its purpose

This menu gives you access to certain information about the software: the online help, the SOPROLIFE clinical guide, software updates via Sopro Update, the Help update, the software version number and generating an SAV report.

How to get there

By clicking on the “Help” menu or pressing F1, then on the required function

3.7.1. Help sections: help index

Clicking on “Help” and then “Help index” or click on the icon opens the Sopro Imaging online help system.

This action opens the Sopro Imaging interactive help. You can also invoke this interactive help by pressing F1 from any point within the application.

3.7.2. Clinical booklet

To access the SOPROLIFE clinical booklet, click the « Help » menu > « Clinical Guide » or the icon.

Thanks to this manipulation, you can directly open the SOPROLIFE clinical booklet.

3.7.3. SPRO Update: live software updates

To use Sopro Update, you must be connected to the Internet.

Clicking on this option enables you to gain access to the Sopro Imaging update platform.

3.7.5. SAV Report

Click on “Help” then select “SAV Report”:

This function is solely for our technicians. It allows them to perform a system verification procedure.

3.7.6. About Sopro Imaging

Click on “Help” menu and then choose “About Sopro Imaging”:

This opens a dialog box that tells you the version number of the software you are using.
4. Configuring Sopro Imaging

Its purpose

The Setup panel is the principal means of configuring most features of Sopro Imaging. It contains eleven tabs that allow you to personalize the operation of the software as a function of the settings specified in each one.

How to get there

Click on the "File" menu and then choose "Setup":

This opens the Setup panel:

4.1. The Main tab

This is the tab displayed by default. To do this, click on the “File” menu then choose “Setup”. It incorporates twelve main options.

4.1.1. Images folder

The Sopro Imaging software lets you choose the folder where you want to store images. By default, they will be stored in the following folder: C:\Program Files\Sopro Imaging\Images\. 

To choose another location instead, click on the three little dots on the right-hand end of the "Images folder" box. A Windows dialog box opens:

To change folder, select it from the preferred list, as shown above, and then accept your choice by clicking on "OK". 

This images folder will be used in case of networking. 

For more information, please refer to point 8 of this chapter.
4.1.2. Maintenance

This function recovers files which have been deleted such as images, a patient file or a practitioner file:

First of all, it is necessary to restore the files which are in the basket on your desk, you must open the basket, select the removed files, and right click to restore.

Then open Sopro Imaging, click on Main tab in the Setup panel. A window dialogue box opens. Click on “OK” to restore the information.

A dialogue box appears. It confirms a successful operation.
4.1.3. Data saving folder

Each time you exit the program, you will be prompted to perform a data backup. You are recommended to backup the data to an external medium. You have to specify the desired backup path. To do this, click on the three little dots at the right-hand end of the "Data Saving folder" box. A Windows dialog box opens:

![Screenshot of the data saving folder dialog box]

Now choose the folder into which you want to backup the data, remembering that you must choose a path to a physical disk other than disk C. If you make a mistake or if you want to change the path entered in this box, simply click on the small scissors icon to the right of this box and then repeat the operation above.

⚠️ WARNING

If no path is specified, then no backup will be performed.

A dialogue box appears. It confirms a successful operation.
4.1.4. Language

The “language” is the language selected by default when Sopro Imaging runs. To choose the language, select it by clicking on the dropdown menu indicated by a downward-pointing arrow:

If the main language is changed, you need to close and relaunch the application for the change to take effect.

4.1.5. Teeth numbering:

There is the possibility to choose teeth numbering apart from the language. Click on the pull-down menu in order to select teeth numbering:

4.1.6. Old image software folder:

If you are used to working with other imaging software, Sopro Imaging enables you to visualize the images acquired with the former application.

To activate that function you have to:

- Click on the pull-down menu and select the imaging software used til then (ACTEON, WVISIO 32, JULIEW)
- In the “Old software images folder” field point out the folder containing the older images by clicking on the three small dots.

To activate that function, you just have to validate your choice by clicking on “OK” and close the application.

For this function to be effective, you have to launch the software again. The former images will then be displayed in the corresponding patient’s files.

They will be sorted as “external images” and will be marked with the following stamp:
WARNING

This handling allows only displaying the images of the former application but under no circumstances will they be automatically converted to Sopro Imaging. It is recommended that this installation be made by a Sopro technician.

4.1.7. Security

This function secures the software access but also encodes the patient data. It is explained in detail in point “2” of this chapter.

4.1.8 LUSI Link

This function allows you to partially link a dental office management application you might be using with the Sopro Imaging X-ray software.
To take advantage of this link, open the dropdown menu and choose the option corresponding to your management software database as shown below:

![Dropdown menu]

Now, accept your choice by clicking on “OK”.

IMPORTANT:
To perform this operation, you are recommended to contact the authorized Sopro engineer who installed the system (to prevent any mistakes).

NOTE

LUSI link is available in every language. For more information, please refer to the manual LUSI operation situated in “Documents” file in the Cd-rom.

It is possible to automatically update patient folders depending on modifications that have been done on the management software.

To do this, check the box:

☑️ Always update the files
4.2. Options tab

This particular tab allows you to set up various Sopro Imaging software options.

4.2.1. Automatically ask for a X-ray-image location

This option allows you to choose the location after each X ray acquisition.

![NOTE]

This option is checked by default.

4.2.2. Show the test pattern at the beginning of the day

In compliance with standards in force in certain European countries, Sopro Imaging enables you to display a screen test grid for adjustment once every day. When you enable this option, it allows you to check that the screen brightness and contrast are properly adjusted before starting work.

To enable this option, you should first put a check mark in the "show the test pattern at the beginning of the day". This function will only appear next day when the program launched first in the day.

When this occurs, the following image will display, on the entire screen:

![Image]

You can then adjust the screen so that the contrast and brightness allow you to view properly all the indicated areas.

Once you have made the necessary adjustments, just click one time on the screen with your mouse. Sopro Imaging will start and prompt you to select a patient file or create a new file.

4.2.3. Do not allow X ray removal

This function is designed to prevent you from deleting any X ray images taken with the Sopix/PSPIX systems.

![NOTE]

This option is checked by default.
4.2.4. Print x-ray exposure information

SOPRO-Imaging allows you to print information regarding x-ray images exposure and energy. This option is only available with a SOPIX² system.

4.2.5. Print the status and Soproshade image numbers

This function allows you to print or not to print the label numbers in the status

4.2.6. Always fill in the patient research list

This function displays the patient research list.

NOTE
This option is checked by default.

4.2.7. Show visual keyboard

This function allows you to display the virtual keyboard for any information you want to add in "Patient" and "Doctor" windows or any comments about the image.

4.2.8. Filter patients by doctor

SOPRO-Imaging allows a patient's files access restriction to only one doctor.

4.2.9. Show the confirmation message when closing SOPRO-Imaging

This function allows a confirmation message display of data's saving when closing SOPRO-Imaging software.

NOTE
This option is checked by default.

4.2.10. Show the "new patient" command if SOPRO-Imaging is linked to an external software.

In case of link to an external software, it is possible to hide the "new patient" command in SOPRO-Imaging.

NOTE
This option is checked by default.

4.2.11. Using the spacebar to change a box in the SOPROLIFE status

In the SOPROLIFE status, you can manually change a location by using the keyboard spacebar or the mouse thumbwheel. To do this, tick this box.

NOTE
This option is ticked by default.

4.2.12. Displaying the images without enhancement filter when status opened

When a status is opened, the x-ray photos are displayed with an enhancement filter. To deactivate this filter, tick this box.
4.2.13. Reverse the patients’ last name and first name

This function allows you to reverse patients’ last name and first name when searching for a patient file. To do this, check the box.

4.2.14. Confirm saving of color images and films

After capture of one or more image(s) or video(s), you can confirm they have been saved by closing the capture window. To do that, check the box.

4.2.15. Deactivate the camera button

This function can be used to inhibit the “SoproTouch” tactile key on the intraoral camera.

4.2.16. Deinterlace video flow from the camera

By default, video flow from the intraoral camera is deinterlaced.

4.2.17. Hide the labels in the status boxes

This function displays or does not display the label numbers in the status.

4.2.18. Show comments in superposed mode

This function enables you to keep the image on screen while typing a comment.

4.2.19. Print FMS on black background

This function allows you to print the FMS on a black background.
4.3. Shortcuts tab

This tab enables you to create keyboard shortcuts for all our radiology and imaging tools.

To create a shortcut, select the tool of your choice from the drop-down list, then enter the shortcut of your choice in the “Shortcut for the command” box.

For example: to create a shortcut for the command “Rotation”, press Ctrl then D on your keyboard.

Pressing “OK” will automatically validate the shortcut(s) created.
4.4. Appearance tab

This tab lets you choose settings for the working interface. To do this, click on the “File” menu then choose “Setup” and select “Appearance” tab:

4.4.1 Appearance

This menu lets you choose from among the three images display modes for acquisition and consultation. Thus, each practitioner can choose a display mode that suits his working preferences.

By default, the Sopro Imaging software renders images in “design” mode incorporated within an overlay called a “skin”.

To make a change, click on the “Appearance” dropdown menu which lets you change the appearance of the skin (six different colors are available) if you choose to stay in design mode, or lets you choose the “Windows style” mode:

If you click on "OK", the displayed choice is automatically accepted.

NOTE

With Windows Style mode, there is the possibility to limit the number of opened skins between one and six.

4.4.2. Show tool tips

Placing a check mark in this box:

☑ Show tool tips

Displays tool tips when the cursor hovers over a tool.
Each time the cursor hovers over a tool, a tool tip will display (if the system so allows) to explain its purpose. Unchecking this option disables tool tips.

4.4.3 Open images in full screen mode

Placing a check mark in this box:

☑ Open images in full window mode

Displays images in full window mode when you open them, rather than in skin mode or Windows mode.

Unchecking this check box disables the option.
In this case, the default display mode will be Windows mode or design mode, as explained under the point above.

4.4.4. Open the tool box automatically

Check this box:
...is used to choose whether to have the tool box open permanently or not.

It is possible to deactivate this option by unchecking this box.

4.4.5. Limit the number of opened skins

Check this box:

- Limit the number of opened skins

The function Windows Style mode limits the number of opened skins (between 1 and 6).
4.5. **Units tab**

**Its purpose**

This tab lets you parameterize the Sopro Imaging software's measurement tools.

**ATTENTION:**

These measurements must not be used for diagnostics.

**How to get there**

Click on the “File” menu then choose “Setup” and select “Units” tab.

4.5.1. **Angles**

You can change the unit used for measuring angles, the number of decimal places to display, and whether or not to display the grid for plotting.

- To change the angle measurement unit, click on the blue arrow to the right of the "Express in" box, and choose a unit from among degrees, grades and radians. By clicking on the spinbar arrows of the "decimals" box to the right of the measurement unit, you can increase the number of decimal places:

- When a measurement tool is selected, a grid can be displayed on-screen. To display this grid, put a check mark beside the "Show Grid" option (as shown by the arrow). If you don’t want to display this grid, uncheck this option.

- When you click on "Segment’s Color", a Windows dialog box opens so that you can choose another color for displaying the grid.

4.5.2. **Measures**

You can change the length measurement unit, the number of decimal places to be displayed, and whether or not to display the grid for plotting.

To choose settings for these items, follow the same instructions as for the angle measurement, but choose a length measurement unit. By default, the measurement grid displays in millimeters (with measurements expressed to two decimal places) and the grid color is green:

4.5.3. **Extraction**

This tab lets you specify settings for the "levels extraction" tool, which is used for extracting all dots with the same intensity and displaying them in the same color.

By default, the area illustrated by this tool displays in green on the image, with a tolerance of three pixels.

These two settings are parameterizable:

- Clicking on "Points Color" opens a Windows dialog box that lets you change the color.
- To change the surface to be processed, click on the spinbox arrows to the right of the "Area to treat" box, and increase or decrease the value; the maximum value is 10.
4.5.4. Zoom

This tab lets you choose settings for the zoom that is used notably when you use the “zoom/magnifying glass” and the “highlight” tool, which enable you to reveal certain areas on images.

- By default, the zoom size is 50; but you can change this setting, up to a maximum of 100.
- You can choose the line color by clicking on “Border Color”; this action opens a Windows dialog box that lets you select another color for the zoom line.
- It is possible to delete the zoom line by clicking on “No outline”.

4.5.5. 3D View

This tab lets you choose settings for the “3D” tool and specify the projection height. By default, the value is 32 pixels.

You can choose a different value, ranging from 16 to 96 pixels, by clicking on the blue spinbar arrows (up to increase the value, and down to decrease the value).

For more information on using this feature, refer to point 6.2.6 in this chapter.

4.5.6. Default

Clicking on this tool restores the default values of the “Units” tab.

4.5.7. Relief without luminosity filter

Click on this tool to apply a relief without luminosity filter to each X-ray image. For further information on the use of this function, refer to point 6.1.7 in this chapter.

4.6. LUT tab

Its purpose

Enables you to personalize the color pallet of the “Pseudo color” tool.

How to get there

Open the “Patient” menu, and then choose ”Setup”. Click on the “File” menu then choose “Setup” and select “LUT” tab.

. To personalize the color pallet of the “Pseudo color” tool:

Click on the “LUT” tab and select the desired shade by left-clicking with the mouse on one of the 50 color ranges provided in the left-hand part of the dialog box.

The selected shade displays in the right-hand part of the dialog box.

To accept your selection, click on “OK”.

For more information about how to use this feature, refer to point 6.1.6 in this chapter.
4.7. Color images tab

Function

It is used to manage images acquired with an intra-oral camera, within the Sopro Imaging software.

Access

Click on the color images tab, in the Setup panel which may be accessed by clicking on “File” then “Configuration”.

4.7.1. Video Control panel

The presentation of and access to the parameterization displayed below may vary depending on the camera or the computer’s video acquisition board.

A - Protection ID

A number appears when the dongle is connected to the USB ports.

NOTE

This key of protection must be connected to one of the computer’s USB ports to authorize the use of the intra-oral camera in the patient files greater than ten. Otherwise, Sopro Imaging remains configured in demonstration mode for the frame grabbing color and limits its use to the patients’ files ranging between one and ten.

B - Video source

Select the video source (video acquisition board, USB video code, USB camera) to be used for the capture of images.

C - Parameters

C.1 Capture filter

Is used to select the “Video standard” and to make any adjustments: brightness, contrast, etc.

C.2 Capture pin

Is used to select the format video, its compression, the colors/compression space, together with its output size.

C.3 First Crossbar

Is used to select the input video source, by default Video SVideo In.

C.4 Format for the storage of images

By default, the format is Png; however, it may be changed by clicking on the right hand arrow.

To return to live mode after the capture of each image, click on the box provided.
C.5 Video rendering

Is used to visualize the image in its original size, namely 640 x 480 format as well in skin mode, as full window mode, as full screen mode.

To activate this function, click on “1:1”:

<table>
<thead>
<tr>
<th>Video rendering</th>
<th>in skin or full window</th>
<th>in full screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusted</td>
<td></td>
<td>Adjusted</td>
</tr>
</tbody>
</table>

**NOTE**

By default is adjusted to skin mode window, full window mode and full screen mode.

D - Patient data to be sent to the dental lab

An information panel (file number, civil status, date of birth) concerning the patient may be sent to the dental lab. Left hand click to select the information required.
4.7.2. Configuration of an intra-oral camera

NOTE

Here below, all the settings correspond to basic settings to use Sopro intra-oral cameras. In case of use with another intra-oral camera or acquisition board, please refer to the manual « USB connection for SOPRO cameras” in “Documents” file in the Cd-rom.

In Sopro Imaging go to the “Patient” menu then “Setup”, select the “Color images” Tab, and the video source: Sopro cameras driver.

In this Window, click on the « Capture filter » button,

![Capture filter window]

Place the “video Standard” on “PAL_B” if your camera is Pal or “NTSC_M” if it is in NTSC, then click on the "video amp proc " Tab,

![Video amp proc window]

At the installation of the drivers, the parameters of luminosity, contrast, colour and saturation are on the values indicated above. In the contrary case, enter these parameters manually then click on "Apply", then "OK".
Caution: the quality of the image can vary according to the screen used, in the case it would not be appropriate, adjust the parameters

**NOTE**

There is the possibility of carrying out these adjustments when the image is "live". You just have to click on the icon representing the tools box in order to manage directly at the window "Properties".

Click on “Capture Pin” button; place the “Color space /Compression” on “YUY2”.

Click on “Apply” then “Ok”.

**NOTE**

For the first video acquisition in Sopro Imaging, it is necessary to wait approximately 30 seconds to obtain a "Live" image on the screen. Sopro Imaging functions without dongle for the patients files from number 1 to 10; beyond it is necessary to connect a USB dongle.

### 4.8. Movie tab

**Function**

It is used to manage video acquired with an intra-oral camera (within the Sopro Imaging software).

**Access**

Click on the movie tab in the Setup panel which may be accessed by clicking on "File" then "Configuration".
4.8.1. Movie Control panel

The presentation of and access to the parameterization displayed below may vary, depending on the camera or the computer's video acquisition board.

A - Protection ID

A number appears when the dongle is connected to the USB ports.

NOTE

This key of protection must be connected to one of the computer’s USB ports to authorize the use of the intra-oral camera in the patient files greater than ten. Otherwise, Sopro Imaging remains configured in demonstration mode for the frame grabbing color and limited its use to the patients' files ranging between one and ten.

B - Video source

Select the video source (video acquisition board, USB video codec, USB camera) to be used for the capture of images.

C - Parameters

C.1 Capture filter

Is used to select the “Video standard” and to make any adjustments: brightness, contrast, etc.

C.2 Capture pin

Is used to select the format video, its compression, the colors/compression space, together with its output size.

C.3 First Crossbar

Is used to select the Input video souce, by default Video SVideo In.

C.4 Video sequence compression format

To set the recording of the movies in real time, please make sure that the following settings are selected:
• Compression for movies: “ffdshow video encoder”
• Click on the check box “On the fly compression”
• The compression quality must be 85% minimum.

C. 5 Maximum length of a film

The maximum length of a film is 300 seconds. By default, this time is 60 seconds. It may be modified by clicking on the arrows:

• Up to increase the time
• Down to decrease it.
4.8.2. Configuration of an intra-oral camera for video clip capture

In Sopro Imaging go to the "Patient" menu then "Setup", select the "Movie" Tab, and the video source: Sopro cameras driver.

In this Window, click on the « Capture filter » button,

Place the "video Standard" on "PAL_B" if your camera is Pal or "NTSC_M" if it is in NTSC, then click on the "Amp video proc" Tab,

At the installation of the drivers, the parameters of luminosity, contrast, colour and saturation are on the values indicated above. In the contrary case, enter these parameters manually then click on "Apply", then "OK".

Caution: the quality of the image can vary according to the screen used, in the case it would not be appropriate, adjust the parameters

NOTE
There is the possibility of carrying out these adjustments when the image is « live ». You just have to click on the icon representing the tools box in order to manage directly at the window "Properties".

Click on “Capture Pin” button; place the “Color/Compression space” on “YUY2”.

Click on “Apply” then “Ok”.

![Properties window](image)

**NOTE**

For the first acquisition in Sopro Imaging, it is necessary to wait approximately 30 seconds to obtain a "Live" image on the screen. Sopro Imaging functions without dongle for the patients files from number 1 to 10, beyond it is necessary to connect a USB dongle.

4.8.3. Dongle installation

For further information, please refer to point 4.7.3 of this chapter.
4.9. Filter tab

Its purpose:

Automatically apply filters after each acquisition with a Sopix² digital x-ray system, PSPIX system or SOPIX first generation.

How to get there?

Open the "File" menu and then select "Setup" to open the main window for the configuration panel; then click on the "Filter" tab.

4. 9.1 Filter setup tab

A - Size 1 horizontal for second premolar and molars

This function allows you place a Size 1 sensor horizontally for the second premolar and molars.

B - Showing image on four views

The four labels displayed are, from left to right and from top to bottom:

<table>
<thead>
<tr>
<th>SOPIX</th>
<th>SOPIX²</th>
<th>PSPIX</th>
<th>PSPIX²</th>
<th>X-MIND ONE</th>
</tr>
</thead>
<tbody>
<tr>
<td>image with no processing</td>
<td>Standard image</td>
<td>Standard image</td>
<td>Standard image</td>
<td>Standard image</td>
</tr>
<tr>
<td>image with application of relief</td>
<td>Sopix² X1 image</td>
<td>Border enhancement 1</td>
<td>Border enhancement 1</td>
<td>Border enhancement 1</td>
</tr>
<tr>
<td>image with contour enhancement</td>
<td>Sopix² X2 image</td>
<td>Border enhancement 2</td>
<td>Border enhancement 2</td>
<td>Border enhancement 2</td>
</tr>
<tr>
<td>image with gamma correction</td>
<td>Sopix² X3 image</td>
<td>Border enhancement 3</td>
<td>Border enhancement 3</td>
<td>Border enhancement 3</td>
</tr>
</tbody>
</table>

You can view one of these four images by clicking on it once.

If no action is performed with these images within 30 seconds, the image with no processing done will be displayed on-screen.

To obtain this display each time you take an X-Ray image, put a check mark beside this option “Show image on four views”. If the option is left unchecked, the image will display on-screen by itself.
C - Personalized filters optimization

Three buttons allow you to select the system on which the filters will be applied. Each filter can be customized according to acquisition, gamma, brightness and contrast preferences. The Sopix², PSPIX and 1st generation SOPIX systems store the recorded values and apply them to each acquisition.

**C1 - Apply a gamma**

This function allows to increase or decrease the gamma. You just have to slide the cursor on the left/right axis, with a scale from 0.34 to 3. By default, this filter will be applied after each acquisition.

**C2 - Apply a luminosity**

This function allows to increase or decrease the luminosity. You just have to slide the cursor on the left/right axis, with a scale from -100% to +100%. By default, this filter will be applied after each acquisition.

**C3 - Apply a contrast**

This function allows to increase or decrease the contrast. You just have to slide the cursor on the left/right axis, with a scale from -100% to +100%. By default, this filter will be applied after each acquisition.

**C4 - Setting the filter**

This functionality is used to increase or decrease the filter’s intensity. To do this, simply slide the cursor on the left/right axis. Then this filter will be applied by default after each acquisition.

**NOTE**

A preview window allows controlling in real time the rendering of each filter adjustment.

**NOTE**

For each filter setting, right-clicking the cursor bar resets the value by default.

**G - View mode**

Using the dropdown menu choose the view mode of acquired image according to the selected filter. For more information, please refer to chapter 6.2.5 of this manual.

**H - Keep acquisition filter after reset**

After an image reset, this function allows you to keep the three mentioned above filters. For more information, please refer to the point 6.1.8 of this manual.
4.10. Radiology tab

To select the radiology product(s) that you want to use, open “File” menu > “Setup” menu > “Radiology” tab, and click on the images(s) corresponding to the product(s). Therefore, the acquisition module of the selected product will be opened every time you open a patient file in order to use it.

For information purpose, you can indicate which generator is used with voltage and intensity settings.

Then, select the format for the storage of images in the drop-down menu. By default, images are stored in PNG format.

4.11. PSPIX² setup

NOTE

To be setup, the PSPIX² has to be switched on and connected with an Ethernet cable to:
- a computer in case of single-user configuration
- a network in case of single or multi-user configuration

Be sure that you have selected PSPIX² in the Radiology tab. Please refer to the chapter “4.10 Radiology tab”.

Click on the setup button in the PSPIX² acquisition module to open PSPIX² setup.

Configuration tab

A - Network adapter

Select the network adapter where you have previously connected the PSPIX² by clicking on the drop-down menu.

B - Workstation name

For information purpose, you have the possibility to rename your workstation.
C - PSPIX selection

- Choose the PSPIX² you want to use by clicking on the corresponding serial number in the drop-down menu.

**NOTE**

The PSPIX² serial number is located below the product or appear on the start-up window when you switched on the PSPIX².

- Click on the single-user or multi-user button depending on the desired configuration.
- In case of single-user, click on “Connection” to validate.
- In case of multi-user configuration:
  - Select your workstation number in the drop-down menu. Only the available numbers appear in the list. This workstation number is needed to book the PSPIX² for your workstation from the control panel or on the PSPIX² touchscreen. When you booked the PSPIX² for your workstation, this number also appears on the touchscreen.
  - Click on “Connection” button. A confirmation window appears. Click on “OK” to validate.
  - Choose the way to book the PSPIX² by ticking the correct box: from the PSPIX² touchscreen, or from the workstation, or both solutions. By default, both solutions are selected.
  - Setup your reservation duration in seconds by clicking on up and down arrows. During the reservation duration, you are able to insert an imaging plate in the PSPIX²; the scanned image will be directly sent and displayed in your workstation. By default, this duration is configured at 40 seconds.

- Setup the PSPIX² standby delay in minutes by clicking on up and down arrows. By default, this delay is configured at 15 minutes.
- Click on “OK” to validate.

**Image tab**

- Choose your scanning mode between “high definition” and “fast mode” in the list.
- You have the possibility to retrieve the last scanned image on your workstation in case of network/connection problem between the PSPIX² and another workstation. Click on the corresponding button to receive the image on your workstation.

**NOTE**

Pay attention to open the good patient file before clicking on “Retrieve the last scanned image”.

**Status tab**

This tab is an information tab. It displays several information on the connected PSPIX² such as IP address, subnet mask, gateway, MAC address, firmware and FPGA versions etc…

**Warnings table tab**

In case of a warning message appears on the PSPIX² touchscreen, you are able to check which actions can be done to solve the problem in the warnings table tab.

**About tab**

This tab is an information tab. It displays information on the PSPIX² version and copyright.
4.12. X-MIND ONE / PSPIX GENERATION 1 - setup

Be sure that you have selected X-MIND ONE and/or the PSPIX in the Radiology tab. Please refer to the “chapter 4.10 Radiology tab”.

Click on the setup button in the X-MIND ONE or the PSPIX acquisition module to open X-MIND ONE or the PSPIX setup.

NOTE
The drivers (to be found on the CD-ROM) first have to be installed and the X-MIND ONE and the PSPIX system connected to a computer which is switched on.

“Scanner” tab

C1 - “Status”

The heading “Status” indicates the number of the connected system, its version and serial number.

C2 - “Image Scanning”

The “Show Image Preview and Dental Chart” check-box is an obsolete function retained in order to preserve ascending compatibility with older systems.

Choose the image resolution. To do so, click on “Super” for very high resolution images or “High” for high resolution images.

C2a - “Image Capturing”

The “Show Image Preview” check-box is an obsolete function retained in order to preserve ascending compatibility with older systems.

C2b - “Image Processing”

The Noise Filtering check box should normally be selected. Noise filtering make images smoother when they are taken at low doses.
The Automatic Density Adjustment check box should normally be selected. Automatic density adjustment evens out the grayscale values.

The Sharpen Filtering check box should normally be selected. When selected it adds default sharpening to all new images. The default value can be changed by entering a new value into the Sharpen Matrix size edit box. Values from 0 to 25 can be entered. The factory set value is 7.

**C3- “Image Processing”**

The “Noise filtering” check-box enables you to apply an anti-noise filter to the images.

**C4- “Retrieve last image”**

Following a communication fault (e.g. PC crash or network problem), the last scanned image cannot be transmitted to the software. However, it can be retrieved afterwards.

**NOTE**

The LAST scanned image can only be retrieved if the PSPIX system is running. This means the X-ray will be lost if the PSPIX system has stopped operating.

To retrieve the last image:

1. Remedy the problem which led to the communication fault.
2. Open the SOPRO Imaging software and the patient file, press the “Ctrl” button, then click on the yellow icon on the PSPIX control (dialog box).
3. The “PSPIX Setup” window is displayed. Click in the **Retrieve Last Image** check-box to retrieve the last scanned image.

**NOTE**

If necessary, select different parameters (e.g. the resolution) before retrieving the X-ray.

4. Click on **OK** to close the window. The last scanned image is displayed in the patient folder.

**C5- “Scanner serial number”**

The “Scanner serial number” check-box allows you to display the serial number of the PSPIX system on all X-rays.

**“Settings” tab**

Click on the “Settings” tab.

**C.6- “Scanner Connection”**

To configure a X-MIND ONE or the PSPIX system, you need to find out the type of connection being used. To do this, apply one of the following two rules:

**WARNING**

This phase is essential for establishing communication between SOPRO Imaging and a X-MIND ONE or PSPIX system.

- “Direct connection”
This type of configuration allows you to set up a network connection by simply providing the serial number of the X-MIND ONE or the PSPIX system. In "scanner serial number", enter the serial number of the X-MIND ONE or PSPIX system, then select under the heading "Computer network connection" the network interface card of the computer to which the X-MIND ONE or PSPIX system is connected.

When this is done, click on “OK”.

**NOTE**

Please refer to section C7 of this chapter for multi-user connection.

**Or**

b. "IP Based"

This type of configuration allows you to connect to the network by entering the IP address of the X-MIND ONE or PSPIX system. In the "Enable changing IP address" box, manually enter the IP address of the X-MIND ONE or PSPIX system.

**NOTE**

The IP address of the PSPIX system is displayed on the preview screen on startup.

It is possible to change the IP address of the X-MIND ONE or PSPIX system. To do this, manually enter the IP address of your choice.

b.1 PSPIX

To ensure the change takes effect, while pushing the button located on the front of the PSPIX system, click on the “Send to Scanner” button.

The PSPIX system will then validate the change of IP address with an audible beep and restart automatically.

When this is done, press “OK”.

b.2 X-MIND ONE

Touch the service button on the main control panel of the unit.

**b.2.1 Remote**

Select Remote to ensure the change takes effect, while clicking on the “Send to Scanner” button.

**b.2.2 Manual**

Select Manual to write manually, with the help of the keypad, the IP address of the unit. Then press on the tick button to validate. The IP address written here must be the same as the one entered into the X-MIND ONE module setup. If it is not the case, no connection will be possible.

**NOTE**

Please refer to section C7 of this chapter for multi-user connection.

**WARNING**

**IMPORTANT:** The X-MIND ONE or the PSPIX system and the computer must be on the same addressing plan. Also check that the IP address chosen for the X-MIND ONE or the PSPIX system has not already been attributed.

**NOTE**

It is advisable to use an “IP Based” IP connection in the following cases:
- Network of more than 20 computers
- Wifi network
- Failure of “Direct connection” mode.

**C.7- “Multi-Connect”**

To network multiple users of the PSPIX system, check the “Use multi-connect” box.

Select the identification number of the workstation in the “Workstation identifier” combo-list. The computer name is automatically displayed.

The “Scanner Autorelease timeout, seconds” function corresponds to the timeout (in seconds) allotted to the user for acquiring an image according to the system used (X-MIND ONE or PSPIX), after reservation.

When finished, click on “OK”.

To reserve a X-MIND ONE or a PSPIX system, click on the green multi-connect icon at the bottom right of the taskbar.
The following window opens, click on “Reserve the scanner” to reserve the X-MIND ONE or the PSPIX system.

The multi-connect icon flashes, indicating that the PSPIX system is reserved and can be used.

**NOTE**

If the multi-connect icon is yellow, this means the X-MIND ONE or the PSPIX system is already reserved by another user.

**NOTE**

If the multi-connect icon is grey, this means the X-MIND ONE or the PSPIX system is not switched on or it is in the process of starting and is not yet ready to be used.

To cancel reservation of the PSPIX system, click on the flashing green multi-connect icon then on “Free the scanner”.

**“Driver Info” tab**

Click on the “Driver Info” tab.

**C.8- “Driver Info”**

The “Driver Info” tab indicates the version number of the driver used by the X-MIND ONE or the PSPIX system.
This option can be used to have the PSPIX control displayed on the screen even if the Sopro Imaging application is reduced in the taskbar.

**E - Generator**

It is possible to give additional details regarding the generator, especially its brand, its tension (Kv) and its intensity (mA). Those data appear during a printing if “the Print x-ray exposure information” option was checked.

**F - Image file format**

This function allows you to set the image format; several possibilities are available: PNG, JPEG, TIFF, DICOM JPEG, DICOM JPEG without losing anything, DICOM non-zipped, DICOM RLE, DICOM ZIP. Images are retrieved in PNG format by default. It is recommended to keep this format.

NOTE: PNG enables you to keep the original format. However, changing the format of the image can reduce the file size of the image and can thereby save disk space (but there will be a quality loss).
4.13. SOPIX setup

Be sure that you have selected the SOPIX series sensor in the Radiology tab. Please refer to the chapter “4.10 Radiology tab”.

Click on the setup button in the SOPIX acquisition module to open SOPIX setup.

4.13.1. Sopix USB (1st generation) Setup tab

A - Box

When the system is connected, Sopro Imaging retrieves information items from the "Box" input concerning:

- the serial number;
- the electronic version number;
- the programming version of the "firmware" card.

B - Sensor

When Sopro Imaging detects the system and recognizes the sensor, it enables the following information to be displayed:

- the serial number;
- the type of sensor connected: A for size 1, B for size 2, and X when Sopro Imaging detects a sensor connection error. If this happens, refer to point 3.5.1 in this chapter;
- the number of exposures, i.e. the number of X-Ray images taken with this sensor.

C - The system search input

This input is only available if the Windows operating system is XP SP2. By default when Sopix is installed, this panel indicates that Sopix USB is connected. If another Sopix system in the range is used, it is possible to detect it via this configuration panel. If the version of the operating system installed is an earlier version, a panel appears.

It is possible to instruct the software not to activate the SOPIX® functions. To do this, click on “No Sopix”.

This option is used on consultation and camera work stations.

D - Timeout delay

The "Timeout delay" is the time interval necessary for reinitialization of Sopix to make sure that it is continuously operational. By default, this time interval is five minutes. You can change it by clicking on the spinbar arrows: the Up button increases the time, and the Down button decreases the time.

E - Acquire in high resolution

Putting a check mark beside this option means that acquisition will be performed by default in high resolution each time Sopro Imaging is started. If this option is not checked, the acquisition mode will be low resolution.

F - DC type generator

There are currently two types of generators on the market: AC and DC. For a high-frequency generator, put a check mark beside the DC box: X-Ray images will be rendered with better quality.
If there is no check mark beside this option, then Sopro Imaging considers by default that the generator is of AC type.

**G - Show Sopix control**

Put a check mark beside this option if you want the Sopix control panel to be displayed on-screen permanently. If the option is unchecked, the Sopix control panel will only display when the system is ready for acquisition.

**H Permanently ready to acquire**

This functionality is proposed by default. It offers the user important room for maneuvering since the system is permanently armed. Thus you do not have to perform any software or hardware operations before or after acquiring each image.

But without taking an X-Ray image, it is preferable to click on one of the four « sensor illustration » choices represented on the Sopix control box in order to orient the picture before exposure so that your images are always facing the right way.

In order to give the right orientation to the image, you will be able to choose to uncheck the « permanently ready to acquire » box.

In this case, the system will be armed and ready to get an image only when one of the sensors represented in the control box.

This change will be effective only when the user has validated his choice by clicking on « OK » before leaving the setup panel.

**I - Image file format**

This feature allows you to set the image format; several possibilities are available: PNG, JPEG, TIFF, DICOM JPEG, DICOM JPEG without any loss of quality, DICOM non compressed DICOM RLE, DICOM ZIP.

By default, images are retrieved in PNG format. It is recommended to keep this format.

**NOTE:** PNG enables you to keep the original format. However, changing the format of the image can reduce the file size of the image and can thereby save disk space (but there will be a quality loss).
4.13.2. Sopix Wireless (1st generation) Setup Panel

A - Box

When the system is connected, Sopro Imaging retrieves information items from the "Box" input concerning:

- the serial number;
- the electronic version number;
- the programming version of the "firmware" card.

B - Sensor

When Sopro Imaging detects the system and recognizes the sensor, it enables the following information to be displayed:

- the serial number;
- the type of sensor connected: A for size 1, B for size 2, and X when Sopro Imaging detects a sensor connection error. If this happens, refer to point 2.4.1 in this chapter;
- the number of exposures, i.e. the number of X-Ray images taken with this sensor.

C - The system search input

This input is only available if the Windows operating system is XP SP2. When the installation procedure is achieved, the system is connected. Sopro Imaging then displays the COM port with which it communicates (in this case, port 12).

D - Test link and batteries

This function helps testing the state of the transmission between the box and the computer during the installation, as well as the battery level. It is necessary to test these elements during the installation phase, respecting the instructions contained in the installation manual.

E - Restore factory settings

Factory settings are set by default:

This option parameterizes a certain number of functionalities that will have an incidence on the running mode, in this case:

<table>
<thead>
<tr>
<th>Factory Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time for box lighting - finger pushing the button</td>
</tr>
<tr>
<td>Time for the box extinction</td>
</tr>
<tr>
<td>Waiting time for X-rays</td>
</tr>
</tbody>
</table>

F - Acquired in high resolution

Putting a check mark beside this option means the acquisition will be performed by default in high resolution each time Sopro Imaging is started. If this option is not checked, the acquisition mode will be low resolution.

G - DC type generator

There are currently two types of generators on the market: AC and DC. For a high-frequency generator, put a check mark beside the DC box: X-Ray images will be rendered with better quality. If there is no check mark beside this option, then Sopro Imaging considers by default that the generator is of AC type.
H - Compressed acquisition

This function reduces the image size while it’s being transferred to the computer, i.e. to reduce the global acquisition time with no effect notable on the image quality. The compressed acquisition is proposed by default. You can choose to uncheck the box, making the time transfer longer.

I - Restore Sopro Imaging settings

Factory settings are set by default. It’s recommended you change them into Sopro Imaging settings. You have to click once on the button « Restore Sopro Imaging settings » and validate by clicking on « OK ».

This option parameterizes a certain number of functionalities that will affect the running mode, in this case:

<table>
<thead>
<tr>
<th></th>
<th>Sopro Imaging Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time for box lighting – finger pushing the button</td>
<td>0.2s</td>
</tr>
<tr>
<td>Time for the box extinction</td>
<td>4s</td>
</tr>
<tr>
<td>Waiting time for X-rays</td>
<td>180s</td>
</tr>
</tbody>
</table>

J - Show Sopix control

This option can be used to have the SOPIX Wireless control displayed on the screen even if the Sopro Imaging application is reduced in the taskbar.

K - Rearmament after an acquisition

This function (whichever acquisition mode you choose) rearms the system just after an acquisition. Most of all, it enables the user to proceed to a new acquisition without any handling on the controller. By checking this box, a window is displayed which enables you to adjust the time in seconds before the system goes into sleep mode. The default value is fixed at 60 seconds.

NOTE: By increasing the system rearmament delay, the autonomy decreases.
L - Ready to acquire when powering on

This function is recommended when the distance from the PC to the system is greater than 10m, when the computer is temporarily busy or when the system is out of the communication field. As soon as it is powered on, it is ready to get X-Ray images. After the timer is triggered, the user has five minutes to transfer the image to the computer.

⚠️ WARNING

If the image has not been transferred within five minutes, the information will be lost.

M - Image file format

By default the image file format is jpeg with a 90% level of compression. If the “Compressed acquisition” box is not checked, the compression level may evolve from 75% to 100%. It is also possible to use PNG, TIFF, DICOM JPEG, DICOM JPEG without loss, DICOM non compressed, DICOM RLE, DICOM ZIP. formats.

NOTE: In any case, it is recommended to keep the original image format.
4.13.3. Sopix² Setup Panel

A- Interface

When a Size 1 or Size 2 system is connected, Sopro Imaging retrieves at the “Interface” input information about:

- the serial number;
- the electronic version number;
- the programming version of the “firmware” card.
- The exposure numbers, that is to say the acquisition number taken by the sensor.

When you connect a second SOPIX² Size 1 or Size 2 system, Sopro Imaging retrieves all the information at the “Interface” input.

To view the technical information of the Size 1 sensor, click the Size 1 button and, reciprocally, for the Size 2 sensor.

B- The SOPIX² system search input

When the system is connected, Sopro Imaging automatically retrieves information regarding the USB port voltage.

It is possible to instruct the software not to activate the SOPIX® functions. To do this, click on “No Sopix²”.

This option is used on consultation basis and camera work stations only.

C – Permanently ready to acquire

This functionality is proposed by default. It offers the user a large manoeuvring since the system is permanently armed. Thus you do not have to perform any software or hardware operations before or after acquiring each image.

But without taking an X-Ray image, it is preferable to click on one of the four « sensor illustration » choices represented on the Sopix control box in order to orient the picture before exposure so that your images are always displayed on the right way.

In order to give the right orientation to the image, you will be able to choose to uncheck the « permanently ready to acquire » box.
In this case, the system will be armed and ready to get an image only when one of the sensors will be represented in the control box.
This change will be effective only when the user validates his choice by clicking on « OK » before leaving the setup panel.

D- Show Sopix control

This option can be used to have the SOPIX² control displayed on the screen even if the Sopro Imaging application is reduced in the taskbar.

E - Rearmament after an acquisition

This function (whichever acquisition mode you choose) rearms the system just after an acquisition. Most of all, it enables the user to proceed to a new acquisition without any handling on the controller.

F – Generator

It is possible to give additional details regarding the generator, especially its brand, its tension(Kv) and its intensity (mA). These datas appear during a printing if the option “Print x-ray exposure information” were marked.
G - Image file format

This function allows you to set the image format; several possibilities are available: PNG, JPEG, TIFF, DICOM JPEG, DICOM JPEG without loosing anything, DICOM non-zipped, DICOM RLE, DICOM ZIP. Images are retrieved in PNG format by default. It is recommended to keep this format.

NOTE: PNG enables you to keep the original format. However, changing the format of the image can reduce the file size of the image and can thereby save disk space (but there will be a quality loss).

H - See the information on X-Mind Unity

This function is proposed by default when a Sopix/Sopix² system is detected. By unchecking this option you can hide the information related to this system. Even if the information issued by the X-Mind unity generator no longer appears on screen, they are saved with each image when available.
5. Operation of image processing

5.1. The patient file

Its purpose

Enables access to images acquired using the Sopix, PSPIX, SOPROLIFE systems or the SOPRO cameras and stored within Sopro Imaging.

How to get there

Open a patient file, as explained in point 3.2.2.

Once the file has been opened, all the patient's images are displayed vertically in chronological order. The latest X-Ray image always displays at the top left of the window.

When you allow the cursor to hover over an X-Ray without clicking on it, the following information displays at the bottom left of the window:

- the date the X-Ray image was taken;
- the number of the tooth, if it was entered in the location box;
- the notes, if notes were entered in the notes box.

NOTE

Each label has a date that is permanently displayed. For an X-ray, if it was acquired using the Sopix system (and if the X-Ray image was not imported via a scanner, for example), it is the acquisition date. This date is not modifiable.
5.2. Change display

Its purpose

Enables you to set the display mode for the patient’s folder. The modularity offered enables each person to choose a user-friendly mode that fits his/her working habits.

How to get there

To gain access to the display settings, open the “Display” menu:

5.2.1. The tool bar

By clicking on the “Display” menu, “Tool bar “, the display of the tool bar under the menus is activated or deactivated.

For further information, please refer to the point 6.5 of this chapter.

5.2.2. The status bar

Clicking on “Status Bar” enables or disables the display of the status bar at the bottom of the patient file, which allows you to see image information (as explained in point 5.2.1) when the cursor is allowed to hover over one of the labels.

To show or hide the status bar, left-click on the Status Bar entry in the “Display” menu:

If you see a check mark (✓) beside Status Bar, it means that the status bar is visible; if there is no check mark, it means the status bar is hidden.

5.2.3. Test pattern

Clicking on « Test pattern » displays a screen test grid anytime during the day. When you enable this option, it allows you to check that the screen brightness and contrast are properly adjusted before starting your working session.

It is also possible to refer to that pattern when you launch the program for the first time in the morning. In this case, you must refer to the explanations in point 4.2.2.
5.2.4. Show drawings

Clicking on « Show drawings » displays permanent drawings on color images, x-rays, FMS, and SoproShade folders.

5.2.5. Display mode for patient file images

You can set the display mode for all images in the patient's folder. You can change the way the information in the patient folder is displayed: you can choose to display all, or display by category, or display as a function of the date or location.

By default the patient’s images display in label mode. The latest image always displays at the top left of the window.

In each label, both the date and the location are displayed (if they have been filled in).

- The date available on the label will be the acquisition date for color images, X-Ray images and video clips (if they’ve been acquired with Sopro Imaging).
- Regarding the scanned documents, imported images and external images, the date available on the label will be the date the image was created.
- The date displayed on the FMS labels corresponds to the day of the FMS’ making.

A - Sort by date, location or type

This feature lets you choose the display mode for the patient's images as a function of the image date, location or image type. Unlike the status bar setting, you cannot deactivate three features. One of the two options has to be enabled, whichever you choose:

- The date is the date on which the image was created. For an X ray acquired with Sopix or PSPIX (or a color image and/or a video acquired with an intra-oral camera), it is the date of acquisition of the image.
- For an imported image of whatever kind, the date displayed will be the date the image was created, not the date on which it was imported into the patient file. In the case of color images, you can edit the date.
- The location is the function that lets you assign the X ray image the number(s) of the corresponding tooth or teeth, by means of a selector that displays with each image. For more information about this feature, refer to point 6.3.2 of this chapter. If you choose to sort the images by this criterion, they will be grouped by location; images that have no location will display at the end of the list.
- The type is the feature that lets you display images by type (x-rays, color images, scanned documents, movie...). If you choose to sort the images by this criterion, they will be sort by date

To choose between the two modes, Click on "Display", then choose "Sort by Date" or "Sort by Location":

A dot (• ) displays beside the selected sorting method. To change from one method to the other, click on the corresponding entry.
B - **Display image labels or details**

To choose to display them in "Details" mode, open the "Display" menu and choose "Details".

A dot (•) displays beside the selected display mode. To change from one mode to the other, click on the corresponding entry.

C - **Display all images, or display them by type**

By default, all the patient's images display. You can also choose to display them as a function of their type.  
To do this, open the "Display" menu and select the type of images you want to display on-screen. For instance, you might decide only to display X-rays.

All other types of images will be concealed, except X-ray images.
The available types are:

- All images
- color images
- X-ray images
- scanned documents
- movie
- imported images
- FMS.
- External images
- SOPROLIFE

A dot (●) displays beside the selected display mode. To change from one mode to another, click on the corresponding entry.

![NOTE]

When you change patients or restart the program, all images are able to be displayed.

### 5.2.7. Dental chart

To display this function, click on the “Display” menu then choose “dental chart” or click on the icon 
If you see a check mark (✓) beside “Dental filter”, it means that this function is visible, if there is no check mark, it means that the dental chart is hidden.

The dental chart allows you to get a representation of adult and/or children’s teeth.

![Click on this button to display the adult's dental chart]

![Click on this button to display the children's dental chart.](#)

Researches can be done according to types of images:

![Color images](image)

![X-rays](image)

![Scanned documents](image)

![Movie](image)
Imported images

FMS

External images

SOPROLIFE.

**NOTE**

The number situated at the bottom right corresponds to the number of acquired images, imported, scanned ... in the patient files

If a tooth is represented in blue, it means that one or several images are assigned to this one. By selecting the blue tooth, it will be transformed to a yellow tooth (to enable you to display the corresponding images by label under the dental filter).
The sensor positioning adapts according to each selected tooth. If one or two contiguous teeth are selected, the image automatically positions in the direction of the sensor and the number of the tooth (or two teeth) is automatically indicated on the image.

**NOTE**

If several teeth are selected, it is the last one which determines the sensor direction; however, the image doesn’t indicate the tooth numbering. If the last tooth is un-selected, it is the next to last tooth which determines the sensor direction and so on...

**NOTE**

Location by drag-and-drop. It is possible to drag-and-drop a thumbnail onto one of the teeth in the dental diagram in order to quickly assign a location to the thumbnail.

It is possible to cancel selected teeth by doing a reset. For that, one must click the “reset” button.

5.2.8. Hiding old images

Images for which the date is too old can be hidden temporarily. In the "View" menu this filter can be applied for images aged less than:

- 2 years
- 1 year
- 6 months
- 3 months
- 1 month
Or

- From the last examination

This filter is disabled on change of patient or when the imaging software is next launched.
5.3. Opening an image or several images

5.3.1. In design mode

A - Opening an image

Unless you set the display mode in the configuration panel (as explained in point 4.4.1), images display in design mode. For more information about image parameterization, refer to point 4.4. of this chapter.

To consult an image, click (in the patient folder) on the image you want to consult. It will open in design mode, and will display in the foreground on the blue background of the Sopro Imaging application:

![Image of Sopro Imaging application](image_url)

The image is now ready for processing with the pallet of available tools.

**NOTE**

When you open an image in design mode, only tools imported with the skin and the menus (in the menu bar) are available. The advantage of this is that your desktop is not encumbered with the program's environment.
B - Opening several images: comparison mode

In design mode, you cannot open more than two images at a time. In this case, the two skins display with the same dimensions. This enables you to compare X-Rays before and after processing. To do this, when an image is open, left-click once on the blue area anywhere around the skin, or else open the “Display” menu and click on “Images List” or click on the icon.

The image already open disappears and the entire patient folder displays; however, you can still identify the open image by the fact that it is the only label highlighted in yellow:

To open another image for viewing (in addition to the image currently being viewed), click once on the said image: the following window will display:
The image you just opened displays on the right.
To keep one of the two images and compare it with an image that is not open, there are two possibilities:

- You can close the image that you no longer need on-screen. To do this, click on the red cross in the top right-hand corner of the skin. The image you want to keep open repositions itself in the center of the screen. Now, click on the blue background around the image, and select another image from the list as explained above.

- Alternatively, when the two images are still open on-screen, click on the blue background and select another image in label mode.

C - Browsing several images: lateral list mode (part I)

Another way to work in design mode is to use the “lateral list” function.

When an image is already open, select the “Display” Menu, then “Lateral List” or click on the button.
On the right of the skin, a list of images appears. It gathers all the images of the current patient. A single click on an item in this list changes the images in the skin.
D - Opening several images: lateral list mode (part II: comparison mode)

The lateral list has a “two images” mode in order to compare images. It works with 2 windows which both display a single image. To activate this mode, when the lateral list is displayed, click on the “Comparison Mode” button.

The skin becomes a full windows mode, ready to select another image. If you select a second image in the lateral list, another window appears beside the first one.
If you click on one of the two windows, a yellow border indicates the one which is active. A new choice in this lateral list changes the content of the active window.

To get back to the “single view” mode, click on the button: the left image reappears in its original skin.

Note: This mode of operation can be applied to the Windows mode with the same functions.

5.3.2. Windows Mode

A - Opening an image

Unlike other modes, Windows mode lets you open one to six images.

To choose to open images in Windows mode, set this mode from the “File” menu > “Setup” > “Appearance” tab, as explained in point 4.1.1.

When an image is open, the image’s toolbar is always positioned underneath the image, but you can resize and move the window on-screen, which is not possible in the other display modes.

To open an image, click on the corresponding thumbnail in the patient’s folder; the window opposite is displayed on screen.
B - Opening several images: comparison mode

To open several images when you are in Windows mode, after opening the first image, click on the "Display" menu, then select "Image list" or click on the icon, then click once on the image you want to open.

The selected image displays to the right of the first:

To compare more than two images, you just have to repeat the operation. By default, the images in comparison mode are displayed side by side on screen, which aids comparison.
To activate “cascade” mode, click on the “Full window” button on any of the images available on the screen. However many images you have opened will be displayed as shown below:

5.3.3. In Full Window mode

A - Opening an image

Full Window mode enables the user to utilise all the space in the Sopro Imaging window. There are two possible ways of choosing to display images in Full Window mode:

- Click on the “File” menu > “Setup” > “Appearance” tab, tick the box “Open images in Full Window”, then validate.

- If an image is open in skin mode, click on the “Full Window” button located in the image toolbar as shown below:

Full Window mode is activated because the appropriate button is lit up blue.
When opening an image in Full Window mode, two arrows are displayed to the right and left of the toolbar which enable the user to review all the images.

B - Opening several images: comparison mode

In Full Window mode, as in Design mode, two images cannot be opened at the same time. There are two possible ways of doing this; after opening a first image:

- Click on the Full Window button to switch to Design mode, then click on the blue background of SOPRO Imaging. The patient's folder appears; select an image in thumbnail mode.

- Click on “Display” > “Image list” or on the icon to display the patient folder and select an image in thumbnail mode.

The image currently being consulted appears in a yellow thumbnail.

The two images appear side by side, taking up all the available space on the screen.

To select another image, follow the same procedure as for Design mode, as described above.
5.3.4. In Full screen mode

Full-screen mode lets you take advantage of all the space on-screen. To choose to display images in full-screen mode, there are two possibilities:

- Open the "Patient" menu, then choose "full screen",
- When an image is open in skin mode, click on the full-screen button in the menu bar of the image, as shown opposite:
5.4. Importing and exporting an image

5.4.1. Importing an image

Sopro Imaging lets you import one or more images. To do this, open the "Image" menu, and then select "Import":

A dialog box opens: browse to where the image is located (in this example, there is a folder called "images" on the desktop of the main workstation)

To select and import several images in one single operation, hold the <Ctrl> key pressed and then click on each of the desired files.
To select several files that are listed in succession, click on the first file and then press and hold down the <Shift> key before clicking on the last file.
The image or images will display in the patient's image folder.

NOTE

Only files of the following types: JPEG, DICOM, PNG, PCX, TIFF, BMP, GIF, FMS, AVI, DOC, DOCX and PDF can be imported.
5.4.2. Exporting an image

Sopro Imaging lets you export the one or several image(s). To do this, open the image you want to export, open the "image" menu, and then select "Export" (or right-click on the label and select "Export")

many options are provided to the user when exporting:

- default filename,
- firstname_Lastname_#,
- firstname_Lastname_#_on_total,
- firstname_Lastname_#_date,
- firstname_Lastname_#_on_total_date,
- etc.....

A dialog box displays. Choose the image(s) and select the file format. Then click on “OK”

NOTE

When an image is exported, its filters and drawings can be kept on condition that there is a check mark beside this option - Apply filters and drawings to exported images”. For more information, please refer to point 5.2.4 of this chapter.

A dialog box will open: choose the location where you want to save the image, and select the file format in which to save it (JPEG, DICOM, PNG, TIFF, BMP,). Only one image can be exported at a time.

Give the exported image a name, and then click on "Save".

In the case of DOC, DOCX, and PDF files the export format cannot be modified.

NOTE

If two images are open, the image that will be exported first will be the last image viewed.
5.5. Deleting an image

To delete one or more images, you should open the "Image" menu then choose "Delete" or right-click on the label and select “Delete”.

NOTE

This operation only works if no image is currently being processed. If an image is open, Sopro Imaging will prompt you to delete this image.

The following selection dialog box opens; the images display in label mode:

- Select the images you want to delete by clicking on them; the label(s) display in yellow. Then click on "Delete selected images".
  If you put a check mark against the option "Confirm for each image", then - after you click on "Delete selected images" - a dialog box prompt displays for each image; decide whether to delete it or not.
- To select all the images, press the "Select All" button.
- To deselect all images, press the "Select none" button.
- To close this dialog box without deleting any image, press the "Keep All" button.

WARNING

The act of deleting images is irreversible, and will permanently delete all information pertaining to the said images. If the computer so allows, the images will be transferred to the garbage.
5.6. Duplicating an image

Its purpose

This feature is recommended for color images, and enables you to duplicate an image. It allows you to make before and after comparisons – mainly from the cosmetic viewpoint. You can only duplicate an open image.

NOTE

This feature lets you clone any kind of image, not just color images, but this is not recommended.

How to get there

To duplicate an image, select and open the image you want to duplicate. Then, open the "Image" menu and choose "Duplicate":

The duplicated image is displayed beside the first image:

The duplicate image is absolutely identical to the original image (including having the same date), and is stored with it in the patient file.
5.7. Copying an image

Its function

This function enables the user to copy a color image or an X-ray into the Windows clipboard.

How to access it

Open an image, choose the “Image” menu > “Copy” or right-click on a thumbnail and select “copy”.

The copied image is saved in the clipboard while waiting to be pasted into a Word, Paint, Photoshop, etc. type of document.
5.8. Sending an image by mail

Its purpose

This feature lets you send any type of image by e-mail (X-ray image, imported image, scanned image, color image, FMS or video clip) that has been acquired or is stored within the Sopro Imaging software.

How to get there

To send an image by e-mail, click on the “Image” menu when the image or resource is being consulted, then go to “Send by mail” or click on the icon or right-click on the label and select “Send by e-mail”:

This operation opens a dialog box which allows you to select the sending images.

To unselect an image, left click the mouse. To select no images, click on “Select none”. Then click on “OK” to validate your choice.

NOTE

This feature only works if the resource that you want to send is open for viewing.

This operation opens the dialog box below:
Now all you need to do is to enter the recipient's address and the subject line of the message before sending it.

**NOTE**

*The e-mail contains the date, the location, and comments of each image.*

**NOTE**

*Sending by email will not work if a MAPI messaging client (e.g. MS Outlook) is installed and configured.*
5.9. Printing one or more images

Its purpose

This feature enables you to print one or more images.

How to get there

To print one or more images, click on the “Image” menu then go to “Print” or click on the icon or right-click on the label and select “Print” or hold down the “Ctrl” and “P” keys on your keyboard:

This action opens a dialog box.

Choose the images you want to print with the aid of the drop-down list.

NOTE

The SOPRO Imaging software handles page-setting automatically, and allows up to twelve images per page.

The X-rays selected for printing are highlighted in yellow. To deselect an X-ray, simply click on it again.

NOTE

By default, traces and measurements are preserved when sending by e-mail.

A control panel is displayed bottom left, which enables you to set the number of images per page, resize the images and comments. You can also choose to display or not display comments (date of X-ray, localisation, comments) and a handwriting area.

Click on “Print”, then “OK” to validate the printing.

NOTE

The document will be printed on the printer declared as default. To specify special settings or to set another printer, open the “Image” menu and then choose “Print setup”:

<table>
<thead>
<tr>
<th>Image</th>
<th>Doctor</th>
<th>Capt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export...</td>
<td>Import...</td>
<td>Delete...</td>
</tr>
<tr>
<td>Send by e-mail</td>
<td>Print...</td>
<td>Print setup...</td>
</tr>
</tbody>
</table>
5.10. Generating reports

Reports can be generated in microsoft word 2010 format. To do this, click on the “image” menu and then “reports...” or click on the Windows icon. Choose the images to print from the list of thumbnails offered, and then the report to use from the list of reports. The report is then automatically generated, saved, and displayed in the word 2010 application. It is possible to find this report by clicking on it in the list of thumbnails; Microsoft word 2010 opens automatically and allows you to read the document. The “edit a report” function in the “image” menu allows you to modify or create a new report based on the template proposed. Please take note of the comments in the report template in order to find the points where data from the imaging software can be inserted.

5.11. Exporting a FMS

To export an FMS, first select the FMS. Once you have selected the FMS, open the “FMS” menu and choose “Export” or right click on the label and select “Export”:

A window opens. Indicate the location where the image is to be saved (the save format is a BMS format). A single status can be exported at a time.

Name the image to be exported, then click on “Save”.

NOTE

In order that the recipient may read the exported image, he has to download SoproShadeReader.
5.12. Delete a status

To delete a status, right click on a thumbnail containing a status, then select “delete” or open a status and select the “Status” menu > “Delete”:

A dialog box opens:

Confirm deletion of the status by pressing “Yes”.

For each X-ray contained in the status, a confirm delete message is generated.

Click on “Yes” if you wish to delete the X-ray or “No” if you wish to keep the X-ray in the status.

⚠️ **WARNING**

*Image delete is irreversible and will finally delete all the information relating to the images. If the computer permits it, these images will be transferred to the garbage.*
5.13. Sending a FMS by e-mail

To send an FMS by e-mail, click on the icon or right click on the label and select “Send by e-mail”.

This action opens the following dialogue box:

Now all you need to do is enter the recipient’s address and the subject line of the message before sending it.

NOTE
In order that the recipient may read the FMS sent, he has to click on the SoproShadeReader link attached in the e-mail. SoproShaderReader download is free.

NOTE
Sending by email will not work if a MAPI messaging client (e.g. MS Outlook) is installed and configured.
5.14. Printing FMS

To print an FMS, click on the icon or right click on the label and select “Print” or hold down “Ctrl” and press “P” on your keyboard:

If the FMS is already open, click on the “FMS” menu and choose “Print”:

This action opens a dialog box:

The software handles page-setting automatically.

Click on "Print", and then click on "OK" to validate the printout.
6. Radiology tools

All the tools presented in this section are for radiology and the interpretation of X-Rays taken with the Sopix / PSPIX systems. The tools are described via examples in skin mode. The functions work the same in Windows mode and full-window mode, but their layout will be slightly different.

**NOTE**

Regardless of the display mode selected, you can reconfigure the main menu bar of the image by rearranging the buttons. To do this when in skin mode, open the left pane; when in Windows or full-window mode, click on the toolbox button to display the rest of the tools. To move a tool from the left-hand menu to the main menu bar, left-click on the tool and hold the mouse button down. The icon detaches from the button and displays enlarged. Then drag the icon onto the desired button and release the left mouse button. The button has now been reassigned. This operation can be repeated at will. You can configure the button’s display using the Sopro Imaging configuration panel. For more information about this capability, refer to point 4.6 in this chapter.

Each tool can be in one of two states: active and inactive. When a tool is active, it is displayed in blue.

### 6.1 Analysis tools

#### 6.1.1. Rotation

The Rotation tool icon looks like this when inactive, and like this when active.

This command allows you to rotate the image in several ways:

- You can rotate the image in 45° steps; to do this, click repeatedly on the Rotate tool.
  - Left-clicking rotates clockwise.
  - Right-clicking rotates counter-clockwise.
- This tool can also be used like a slider switch: hold the left mouse button down and drag the cursor until you obtain the desired position.

The tool is pre-configured for 45° steps, and you can apply a rotation in any direction. Also, if you click on the tool and simultaneously hold down the <Shift> key on your keyboard, the rotation will take place degree by degree.
6.1.2. Symmetry up/down

The Symmetry up/down tool icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Executing this command performs a horizontal mirroring of the image:

![Image of Symmetry up/down tool in action]

Clicking again on the tool restores the image to its original position.

**IMPORTANT:**

If you mirror an X-ray horizontally, you will obtain a result that is totally false in terms of radiological diagnosis. For example, if you apply horizontal mirroring to an X-ray of tooth # UR7, it will look like it is tooth # LR7.

This tool is most frequently used in the case of an analogue X-ray that has been scanned the wrong way around and then imported into Sopro Imaging.
6.1.3. Symmetry right/left

The symmetry right/left tool icon looks like this ![icon when inactive] when inactive, and like this ![icon when active] when active.

**NOTE**

*By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.*

Executing this command performs a vertical mirroring of the image:

![Image of tool in toolbox]

Clicking again on the tool restores the image to its original position.

**IMPORTANT:**

If you mirror an X-ray vertically, you will obtain a result that is totally false in terms of radiological diagnosis. For example, if you apply vertical mirroring to an X-ray of tooth # LL6, it will look like it is tooth # LR6. This tool is most frequently used in the case of an analogue X-ray that has been scanned the wrong way around and then imported into Sopro Imaging.
6.1.4. Pseudo color

The pseudo color tool icon looks like this when it is inactive, and like this when it is active.

![NOTE]

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the “Toolbox” button to display this tool.

Executing this command changes an image from gray scales to color:

![NOTE]

A pseudo-colored image is generated by applying a color to a gray scale (ranging from black to white) in accordance with a transformation.

The image quality is thus enhanced, because the human eye is more sensitive to changes of color than changes in gray scale. The colors of the rainbow are a rich palette that can be used in lots of ways.

The transformation applied is simple (a correspondence table), and thus enables a real-time improvement in the image’s aptitude for analysis and interpretation. This function enables one to better highlight a feature of the image (for detection of a defect in a tooth, extraction of a contour, etc.).

To vary the intensity of this filter on the image, slide the cursor (which also changes to pseudo color mode) from left to right. To restore an initial level, simply right-click on the cursor.

To deactivate this feature, click on the button again.
6.1.5. Zoom

The zoom tool icon looks like this \[\text{when inactive}\] and like this \[\text{when active}\].

To use the zoom tool:

- click on the zoom tool button;
- move the cursor over the image: you will immediately see an enlargement within a magnifying glass box.

To enlarge the entire image:

Left-clicking with the mouse enlarges the entire image.

To shrink the image:

Right-clicking with the mouse shrinks the image:

\[\text{NOTE}\]

The size of the magnifying glass and the border are configurable within the configuration panel, within the "Units" tab. For more information, refer to point 4.5 in this chapter.

To deactivate this tool, left-click on it once with the mouse.
6.1.6. Level extraction

The level extraction tool icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Activating this tool extracts all dots with the same intensity and shows them in color:

Once the function has been activated, you can use the cursor to choose the levels to extract. If you click on a location within the image, all the levels that are the same as the level under the computer cursor will be extracted.

**NOTE**

The color of the dots and the size of the area to be processed are configurable within the configuration panel, within the "Units" tab. For more information, refer to point 4.5 in this chapter.

To deactivate this tool, left-click on it once.
6.1.7. Relief

The relief tool icon looks like this 🌞 when inactive, and like this ⛅️ when active.

![Image]

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand panel of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Activating this function augments certain gray scales, so as to better highlight details that would otherwise be difficult to see. In certain cases, it can even relieve you of the need to take a further X-Ray:

![Image]

To deactivate this tool, left-click on it once.

It is possible to integrate a relief filter without luminosity. To activate this tool, please refer to point 4.5.7 of this chapter.
To change one filter to another, remain on the relief button and right-click on it once.
6.1.8. Reset

The Reset tool icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-screen mode, then click on the "Toolbox" button to display this tool.

Executing this command will undo all the processing that might have been performed on an image. The software always stores the image as it was acquired.

When you execute this command, the following message displays:

![Reset confirmation dialog box]

Clicking on "Yes" restores the image to its original state.

**WARNING**

This action is irreversible.
6.1.9. The “Flashlight” tool

The “Flashlight” tool icon looks like this when inactive, and like this when active.

NOTE
By default, this tool is present in the main tool bar.

Activating this function activates four features, each of which is rendered in alternation when you right-click on the area to be rendered:

- Histogram equalization:

This function adjusts the portion of the image under the highlight so that the histogram is balanced. Thus, certain details will be highlighted, although you may notice deterioration in the X-Ray.
Gamma plus:

This function causes a lightening of the image which better highlights the soft tissues.

- Minus gamma:
This function causes a darkening of the image and highlights the details of all the opaque X-ray areas of the X-Ray.

- Localized pseudo color:

This function allows you to do a pseudo colors/gray scales comparison in a specific area in order to highlight details that would not be visible otherwise.

To deactivate the “Flashlight” tool, left-click on it once.
6.1.10. Histogram

The histogram tool icon looks like this when inactive, and like this when active.

NOTE

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-screen mode, then click on the "Toolbox" button to display this tool.

Activating this function displays the X-ray's histogram:

This function generates a representation of all the gray scales contained in the image, in the form of a histogram.

To deactivate the histogram tool, left-click once on the tool.
6.1.11. Comments

The comments tool icon looks like this when inactive, and like this when active.

NOTE
This function is only available in the calibration and oscilloscope screen.

When this function is activated, a text input appears in the place of the image.

The comments are saved when you click on the comments button to display the image.
6.2. Processing tools

6.2.1. Length measurement

The length measurement tool icon looks like this \(\text{\includegraphics[width=1cm]{inactive.png}}\) when inactive, and like this \(\text{\includegraphics[width=1cm]{active.png}}\) when active.

To gain access to this function, open the right-hand pane of the skin when in design mode by clicking on the button to the right of the image and by clicking on the icon when the software is running in full-screen or windows mode.

An optional grid displays on the image. The grid size depends on the measurement unit chosen in the configuration panel within the “Units” tab (which is documented in point 4.5 of this chapter).

To take a measurement, click on the starting point for the measurement, release the mouse button, and then click on the end point.

It is possible to take measurements using a poly line. For this, left click on the starting point, then right click on the intermediate points and, finally, left click on the finishing point.

The measurement will display immediately in the right-hand pane.

You can repeat the operation several times in order to take several measurements. They will be displayed in the right-hand pane, with a limit of 10 per image:

To delete a measurement, right-click on it in the right-hand pane.
WARNING

These measurements are approximate, and only give a rough idea; under no circumstances should they be used for diagnostics. They may be totally incorrect if the holding is not correct when the X-Ray image is taken.

To overcome holding shortcomings due to defective positioning of the sensor, Sopro Imaging provides a calibration tool that is available when the X-Ray image measurement pane is open. This function allows you to specify a more-precise measurement scale when taking the X-Ray.

To use the calibration tool, before taking the X-Ray image, position an object of which you know the dimensions in the area to be X-rayed, either on the sensor or near the tooth. When the image is rendered on-screen, you will obtain an image that looks similar to the following:

To make a calibration, you have to check the « Calibration » box located on the right. Then you have to click on the starting point for the tool you want to measure, release the mouse button, and then click on the end point. The measurement of the tool will display immediately in the right-hand pane, as represented above.

You then have to inscribe this dimension of the tool in the zone located under the calibration check box. In this precise example we have indicated the number 25, corresponding to the pin dimension, i.e. 25 mm.

Then you have to make the measurements needed as explained above. More precise dimensions will then be mentioned on the image, as shown below:
A calibration has to be made for a given x-ray image. If you wish to use the function for another tooth, you have to renew the operation (take an x-ray image with a measurement tool).
6.2.2. Angle measurement

The angle measurement icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Activating this function allows you to take angle measurements. To do this:

- click on the angle measurement icon; an optional grid displays over the image. The grid size depends on the measurement unit selected in the configuration panel within the "Units" tab (which is documented in point 4.5 of this chapter).

- click on the starting point for the measurement, release the mouse button, then click on the summit of the angle, then release the mouse button, then click on the ending point.

**NOTE**

To disable this function, click on the button again. The last angle measurement taken will still be available if you click on the button again.
6.2.3. Video inversion

The video inversion tool icon looks like this when inactive, and like this when active.

NOTE
By default, this function is present in the main toolbar.

Activating this function reverses the brightness of the X-Ray image. Namely it allows you to convert a gray scale image on a black background into an image on a white background.

To deactivate this function, click on the button again.
6.2.4. Contrast

The contrast tool icon looks like this when inactive, and like this when active.

NOTE

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Activating this function enables you to change the contrast of the image:

To vary the contrast, click on the tool and use the cursor to modify the intensity of the filter.

To return to the default level, right click on the cursor.

To deactivate this function, click on the button again.
6.2.5. Border enhancement

The border enhancement tool icon looks like this when inactive, and like this when active.

Activating this function allows you to enhance the sharpness of the image, which highlights the contours.

To deactivate this function, click on the button again.

**Filters selection:**
Original image: No filter
This selection allows you to display the native image.

**Filter X1, periodontia filter:**
This filter allows you to optimize periodontium diagnosis (tissus supporting the tooth, gengival, alveolar bone, cementum, dental alveolo ligament).

**Filter X2, endodontia filter:**
This filter allows you to optimize the diagnosis for peri apical lesions or infections thanks to the contrast correction on the whole image.

**Filter X3, optimization filter of the amelo dentinal junction**
This filter allows you to diagnose lesions at the interface of the coronal enamel and dentine.
6.2.6. 3D

The 3D tool icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the “Toolbox” button to display this tool.

Activating this function allows you to transform the image in 3-dimensions:

Once you have clicked on this button, you can use the cursor to obtain a cross-section display of the image in 3D.

To deactivate this function, click on the button again.
6.2.7. Density

The density tool icon looks like this when inactive, and like this when active.

NOTE
By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the “Toolbox” button to display this tool.

Activating this function enables you to obtain a cross-section of the image on a section defined via a segment to be plotted beforehand.

To take a cross-section:

- click on the tool, and then click on the starting point of the segment;
- release the mouse button, and then click on the ending point.

The densitometric cross-section appears immediately along the segment. To deactivate this function, click on the button again.
6.2.8. Channels

This channels tool icon looks like this when inactive, and like this when active.

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "Toolbox" button to display this tool.

Activating this function opens a dialog box:

![Adjustment Panel]

This panel allows you to:

- vary the brightness and contrast of the image, by moving the point within the "brightness/contrast" square. These adjustments correspond to the image's histogram.

- apply color filters, by sliding the cursor along each of the color spectrums: R (red), G (green) and B (blue), within the "color channels" panel. To reposition the cursors at their original location, right-click on them with the mouse.

To close the adjustment panel, click on the standard Windows “close” cross.
Example of application of these filters to an image:

To disable this function, click on the tool again, or close the left-hand pane of the skin. If you are using Windows mode, click on the "Toolbox" button to the left of the image.
6.2.9. Implant

The implant tool is represented by the icon when inactive and when active.

NOTE

By default, this function is not present in the main toolbar. To access it, click on the button to open the left window pane of the skin. If the software is in Windows mode or in Full Window mode, click on the “toolbox” button to reveal this tool.

Activating this function calls up a dialog box:

This panel can be used to select:

- the make of implant
- the model
- the diameter
- the length

And visualise the implant and its reference.

To validate a choice of implant, click on the “Insertion” button. The implant is then inserted in the X-ray image.
To move the implant on the image, click on it and hold down the left mouse button. To rotate the implant, right-click click on it and hold, then make the implant rotate.

To remove an implant, select the implant, hold down the left mouse button, move the implant outside the skin then release the left mouse button.
6.2.10 Deleting an image

The image deletion icon looks like this when inactive, and like this when active.

![Image deletion icon]

**NOTE**

By default, this tool is not present in the main tool bar. To gain access to it, open the left-hand pane of the skin by left-clicking once on the handle. If the software is in Windows mode or full-window mode, then click on the "arrow" available on the top right of this pane.

If the software is in Windows or full-window mode, you have to click on the « toolbox » icon to make it appear.

That function enables the deletion of an image anytime (while it is consulted). Activating this function opens a dialog box:

![Delete confirmation dialog box]

Click on « Yes » to confirm the image deletion.

**WARNING**

Deleting an image is an irreversible operation, and permanently deletes any information it contains. If the computer so allows, the images for this patient will be transferred to the garbage. In this case, it is possible to recover files which have been deleted (which is documented in point 4.1.2 of this chapter).
6.3. Management tools

6.3.1. The date

When you take an X-Ray, the date is incremented automatically by the software. It displays at the top left of the working interface.

WARNING

For legal reasons, it is not possible to modify the date on an X-ray.
6.3.2. The location

The location is the function that allows one to assign the X-Ray image the corresponding tooth number(s). To specify them, click once in the box entitled "Location" (to the right of the box containing the date) as illustrated below:

The location selector above displays on-screen. It provides two dental charts:
- the adult dental chart;
- the lacteal teeth dental chart.

- Click on the teeth that you want to number, so as to see them display in the location box. It is possible to number up to eight teeth. Selected teeth display in yellow on the dental chart.
- To deselect one or more teeth, just click on them again.

The selector also allows you to assign one location per area:

- Maxillary
- Mandibular
- Left profile
- Right profile
- six sextants
- quadrants
- Smile
- Portrait
- four bitewings

These latter four functions apply above all to color images.

NOTE

If you decide to fill in the patient’s portrait when you close the location panel, Sopro Imaging will display the following message:

If you click on “Yes”, this automatically retrieves the image into the patient's file.
To accept the location, click again on the “location” box: this closes the panel at the same time.
6.3.3. Comment

You can attach word-processed notes to each X-Ray. This is a reminder that enables you to enter information about the image.
To invoke this feature, left-click once with the mouse in the color cell to the right of the location box ; this opens an editing box into which you can type notes:

To save the notes, left-click again on the colored speech bubble.
The speech bubble then changes color to indicate that notes are present.

When an image is open, it is possible to add comments or insert them automatically. Type the desired comments in the blue input area. To add a predefined comment, click on the button .

A list of predefined comments can be managed by clicking on the button . When the software is first used, this list is empty; it must be filled over time.
6.3.4. Image features

You can consult the image properties at any time. This feature displays a number of information items concerning the image open for viewing and, where possible, enables you to edit them.

There are two means of invoking this feature, which is only available when an image is open:

- you can right-click on the colored notes speech cell (refer to point 6.3.3 in this chapter);
- you can open the "Image" menu and then choose "Properties" or click on the icon

This opens the following window:

Several information items are available in this window:

A. The patient file number, and the patient’s first and last name. You cannot edit the contents of this box; it contains the information entered in the patient’s civil status information file (for more information about viewing the patient’s civil status information, refer to point 3.2.3 in this chapter).

From that zone it’s also possible to move an image (whatever its type) from the patient’s file in use to another.

To do so, you just have to click on the envelope located at the right of the patient’s name. The following dialog box opens:
You just have to choose the patient’s file to which the image belongs by double clicking on its name displayed within the selection box.

The following dialog box opens:

Click on “No” if you don’t want to move the image.

By clicking on “Yes”, the software moves the image instantaneously in the selected patient file.

The image path is entered in the "General" tab of the Sopro Imaging configuration panel. For more information about configuring the image path, refer to 4.1.1 in this chapter.

The contents of this box cannot be edited within the image properties window.

C. The size corresponds to the size of the image

D. The type of image. This information item can be edited by clicking on the blue arrow at the right-hand end of the box. Doing so opens a dropdown menu offering the various types of images supported by Sopro Imaging.

This lets you assign another type to the image, which can be useful above all when the image has been imported.

This is because, by default, Sopro Imaging assigns the color image status to every imported image, and thereby associates the appropriate processing tools with it.

Yes, in the case of a scanned analogue panoramic X-ray, associating the processing tools specific to digital radiology is essential. So, notably in such a case, you will need to change the image type.

You can choose from among the following image types:

- X-Ray image
- Color image
- Scanned document
- Imported image
- Unclassified
- Video
- External image
NOTE

It is not recommended to change the type of an X-ray image.

E. The image acquisition date. You cannot edit the contents of this box.

F. The comments, if comments have been entered for this image. If there are comments, you can edit them within this box.

G. The location (this will be the location specified in the location panel). You cannot edit the contents of this box.

H. The image resolution.

I. The operations performed on the image. This entry lists all processing operations performed on the image; the latest operation displays at the top of the list. At this level of image properties panel only, you can perform a selective removal of certain processing operations undertaken on the image. To do this, click once on the processing you want to undo; the processing will display in blue; then click on the scissors at the right-hand end of this box.

J. The exposure factor allows exposure leveling in case the user finds the image is too dark or too bright.
6.3.5. Closing an image

To close an image, click on the closure cross in the top right-hand corner of the skin, or at the top right-hand corner of the image in full-window mode or Windows mode.

Once the image has been closed, a complete history of the processing operations applied to it is preserved. When you open the image again, the last filter applied displays in the “active” position.
6.4. The drawing tools

6.4.1. Drawing

The drawing tool is represented by the icon when inactive and when active.

Activate this command to switch between normal mode and drawing mode.

At the same time, the window "Drawing options" appears; it is now possible to customize this function.

NOTE
By default, this function is not displayed in the main tool bar; to access it, open the left pane of the skin by clicking once on the lever, with a left click of the mouse. If the software is in Windows mode or full window mode, click on the button "tool box" to display this tool.

6.4.2. Trace

The trace tool is represented by the icon when inactive and when active.

Activate this command to trace lines with or without a termination arrow.

At the same time, "drawing options" appears. In this case, it is possible to customize this function:
6.4.3. Rectangle

The rectangle tool is represented by the icon \(\text{rectangle icon}^\text{when inactive}\) and \(\text{rectangle icon}^\text{when active}\). Activate this command to trace rectangles. It is possible to draw squares by holding down the SHIFT key at the same time, "drawing options" appears. In this case, it is possible to customize this function:

- **Type of trace**
- **Color**
- **Opacity**
- **Thickness of trace**
- **Selection of the type of trace or arrow**
- **Trace details**

Selection tool
Garbage tool
Delete existing traces

At the same time, "drawing options" appears. In this case, it is possible to customize this function:
6.4.4. Ellipse

The ellipse tool is represented by the icon \[ \] when inactive and \[ \] when active.

Activate this command to trace ellipses. It is possible to draw circles by holding down the SHIFT key.
At the same time, “drawing options” appears. In this case, it is possible to customize this function:

```
Type of trace
Color
Opacity
Thickness of trace
Color of infill
Opacity of infill
Trace details
```

6.4.5. Polygon

The polygon tool is represented by the icon when inactive and when active.

Activate this command to trace polygons.

At the same time, the configuration window appears. In this case, it is possible to customize this function:
6.4.6. Text

The text tool is represented by the icon when inactive and when active. Activate this command to enter a text.
At the same time, “Drawing options” appears. In this case, it is possible to customize this function:

6.4.7. Deleting a drawing

To delete a drawing or a trace, activate the double arrow in the bottom right hand corner of the drawing option panel. The following window appears:

Select one element from the trace list, then delete the trace by clicking on the garbage button.
6.5. The tool bar

The tool bar is used for quick access to the main functions.

1. Reach the previous patient
2. Open a patient folder
3. Reach the next patient
4. New patient
5. Print
6. Generate a Word report
7. Send the image by e-mail
8. Image properties
9. Dental chart
10. Sopix/Sopix²/Sopix² Inside acquisition
11. Creating a new status
12. Colour image acquisition
13. Video clip acquisition
14. Soproshade status
15. SOPROLIFE status
16. Acquire a TWAIN image
17. Image list
18. Opening the right side panel giving access to the image list
19. Oscilloscope function
20. Software help
21. Soprolife clinical booklet
7. Imaging tools

7.1 Analysis tool

7.1.1. Rotation

Please refer to paragraph 6.1.1 of this chapter

7.1.2. Horizontal symmetry

Please refer to paragraph 6.1.2 of this chapter

7.1.3. Vertical symmetry

Please refer to paragraph 6.1.3 of this chapter

7.1.4. Zoom

Please refer to paragraph 6.1.5 of this chapter

7.1.5. Reset

Please refer to paragraph 6.1.8 of this chapter

7.1.6. Reticle

This tool is represented by the icon when inactive and when active.

The reticle (or crosshairs) tool enables you to align each color image.

To deactivate the reticle tool, left click on it once.
7.2 Processing tools

7.2.1. Channels

Please refer to paragraph 6.2.8 of this chapter

7.2.2. Deleting an image

Please refer to paragraph 6.2.9 of this chapter

7.3 Management tools

7.3.1. The date

When taking a color image, the date is incremented automatically by the software. It appears in the top left hand corner of the working interface. It may be modified at any time with a left click of the mouse.

7.3.2. Location

Please refer to paragraph 6.3.2. of this chapter

7.3.3. Comments

Please refer to paragraph 6.3.3. of this chapter
7.3.4. Properties of the image

In this window, several data are available:

A. The number of the patient sheet, the last and first name of the patient. This zone cannot be modified and corresponds to the data entered on the patient's civil status sheet (for further information on the consultation of the civil status of the patient, please refer to 3.2.3 of this chapter).

For this, just click on the envelope to the right of the patient's name. This operation opens the following dialogue box:

Just select the patient to whom the image belongs (double clicking on his name which is displayed in the sheet selection box).

The following dialogue is displayed.

Click on “no” to refuse the move.

Clicking on “yes” moves the image to the sheet of the patient selected instantaneously. Nevertheless, Sopro Imaging displays the data concerning the patient's sheet during consultation.

B. The image access path, as entered in the "general" tab of the control panel of Sopro Imaging. For further information on the parameterization of the image access path, please refer to point 4.1.1 of this chapter. This zone cannot be modified from the image properties window.

C. The size corresponds to the size of the image

D. Nature of the image. This information may be modified by clicking on the blue arrow to the right; this calls up a pop-up menu which proposes the various types of images supported by Sopro Imaging. It is therefore possible to assign another property to the image, especially when it is imported.
E. The image entry date. This zone cannot be modified.

F. The comment, if a comment has been recorded for this image. If a comment has been made, it can be modified from this zone.

G. The localization (it recalls the location entered in the location panel). This zone cannot be modified.

H. Resolution of the image.

I. The actions taken on the image. This input lists processing operations performed on the image. The last operation appears at the top of the list. It is possible to delete certain processing operations on the image only from the image property panel. For this, click once on the processing operation to be deleted. It then appears in blue. Then click on the scissors to the right of this zone.

7.3.5. Closing an image

Please refer to paragraph 6.3.5. of this chapter
7.4 Drawing tools

7.4.1. Drawing

Please refer to paragraph 6.4.1. of this chapter

7.4.2. Trace

Please refer to paragraph 6.4.2. of this chapter

7.4.3. Rectangle

Please refer to paragraph 6.4.3. of this chapter

7.4.4. Ellipses

Please refer to paragraph 6.4.4. of this chapter

7.4.5. Polygon

Please refer to paragraph 6.4.5. of this chapter

7.4.6. Text

Please refer to paragraph 6.4.6. of this chapter

7.4.7. Deleting a drawing

Please refer to paragraph 6.4.7. of this chapter

7.5 SoproShade® tools

7.5.1. Image capture

Image capture may be used from the \(\text{icon}\) or by the tactile key Sopro Touch®.

On the other hand, the capture of the image in mode SoproShade 1 or 2 must be done starting from the \(\text{icon}\).

7.5.2. Deleting an image

Please refer to paragraph 6.2.10. of this chapter
7.5.3. The tool box

The tool box is represented by the icon when inactive and when active. Activate this command to access the function filter capture. For this, please refer to paragraph 4.8.1 of this chapter.

7.5.4. Monochrome

The monochrome is represented by the icon when inactive and when active. Activate this command to switch to monochrome video mode (black and white) instead of color mode.

7.5.5. Sending the SoproShade® folder by mail

The envelope tool is represented by the icon when inactive and when active. Please refer to paragraph 5.8 of this chapter.
7.6 The SOPROLIFE tools

7.6.1. The capture mode

The "capture mode" button is represented by the icon. Activating this command starts or continues the capturing of an image in a SOPROLIFE status.

7.6.2. Capturing the image

You can capture the image by pressing the icon or touching the Sopro Key® available on the SOPROLIFE system.

7.6.3. Deleting an image

Refer to subsection 6.2.10. of this chapter.

7.6.4. An image's properties

Refer to subsection 7.3.4. of this chapter.

7.6.5. The toolbox

The toolbox is represented by the icon.

Activating this command allows you to access the Capture filter function. Refer to subsection 4.8.1. of this chapter.

7.6.6. Automatic mode / spacebar

The automatic mode / spacebar, is represented by the icon in the inactive state and by the icon in the active state.

Activating this command allows you to move from a box, location, after each acquisition.

**NOTE**

By default, the “Auto Mode / spacebar” button is always activated. To deactivate this option, refer to chapter 4.2.10.

When the automatic mode / spacebar, is deactivated, use the mouse thumbwheel or the keyboard spacebar to change the location.

7.6.7. Setting an alert

The "set an alert" button is represented by the icon in the inactive state and the icon in the active state.

Activating this command allows you to set an alert on a location of your choice.
7.6.8. Consultation mode

The consultation mode is represented by the icon.

Activating this command allows you to consult all the images acquired during the creation of a SOPROLIFE status.

7.6.9. Comparison mode

The comparison mode is represented by the icon.

Activating this command allows you to compare the images in the same location.

NOTE

To activate the comparison mode, at least two images must be present in a location.

7.6.10. Anti-clockwise direction

The anti-clockwise button is represented by the icon when inactive and when active.

Activating this command enables you to change the direction of image capture. This means the images are captured from right to left.

7.6.11. Closing a SOPROLIFE status

Activating the button will close a SOPROLIFE status.

NOTE

Saving takes effect when a status is closed.
7.7. Video tools

7.7.1. Recording a video sequence

Recording a video sequence is represented by the icon when inactive and when active.

Click on the icon to start and to stop the video sequence.

The two icons below are used to read or pause a video film.

The cursor is used to fast forward or rewind the film.

7.7.2. Recording audio comments

Open the "films" tab in file/configuration. Make sure that the compression format chosen is "ffdshow video encoder".
Make sure that you are in "Compress on the fly" mode in the "Video compression format" selection list. Choose an "audio source" from the list and then adjust to the desired "recording level". In the event of the list being empty, please ensure that a microphone is present and properly connected to the computer.

Pressing the "OK" button automatically validates the choices made.

Launch a video recording in accordance with chapter 7.7.1 of this documentation.

7.7.3. Capture of an image

The capture of an image is represented by the icon when inactive and when active.

It is also possible to capture an image with the Sopro Touch available on the Sopro cameras.

7.7.4. Full window

The icon is used to view the video in full screen mode.
7.7.5. Full screen

Double-clicking on the live video will take you to full screen mode. Use the Escape key or double-click to quit full screen mode.

7.7.6. Slow motion

Once the video is recorded, click on the slow moting button to play the film in slow-motion. Switch between the available speeds (1/2, ¼, 1/8) by clicking successively on the slow motion button. To restart the film in real speed, press “play” button.

7.7.7. Video editing

A window for video editing can be invoked from the “Image” / “Video editing…” menu.

An icon is also available from the toolbar:

This window displays a list of all the videos available for the current patient.

You have two possibilities:

- Link the playbacks of several films and save the corresponding film
  Select the films you want to link in the desired order. Click on ”Register” button to record the corresponding film.

- Save only one part of a film
  Select the film you want to modify. It starts automatically. Cut the part of the film that you don’t want, using the orange arrows. Click on “Register” button to record the corresponding film.

7.8. The tool bar

Please refer to paragraph 6.5. of this chapter
8. Networking

It is perfectly possible to share the Sopro Imaging application if the dental office has a network installed.

Networking consists of sharing the image file containing the patient’s data.

For this, open the configuration panel by opening the “File” menu and then choosing “Setup”:

![File menu]

Then, select the “General” tab.

By default, the “Image Path” entry points to “C:\Program Files\Sopro Imaging\Images\”. 

If a network is being used, you must edit this path by clicking on the three little dots (ellipses) at the right-hand end of this field. This opens a Windows dialog box:

![Folder dialog box]

This path can point to a network address accessible from the various workstations sharing Sopro Imaging application. Once you have entered the path, accept your entry by clicking on "OK".

**WARNING:** It should be made clear that the rights of access to the shared repertory are well parameterized.